


What is QCTool

QCTool provides you with an efficient means of data quality control prior to advanced
processing and interpretation. It is not confined to a special type of data and can be used in
any field where data analyses and handling are involved. It offers three modes of data
display - tables, grids and plots, which, being interrelated, make the cumbersome job of
data checking and editing as easy as a click of the mouse

QCTool also offers a full suite of gravity and magnetic data processing as well as advanced
processing tools for a wide variety of data.



Terms (Notational Conventions)

Point a row of a table (a single data point sample with N associated data
channels)

Channel data representing the same characteristic and forming a column of a
table

Line a data subset in a sequence of measurements shown in QCTool
normally as a separate spreadsheet

Fiducial Channel
a channel containing reference information (time of measurement,
etc.) arranged in a certain order; as a result each point has its own
fiducial, an index to be utilized as a basis for merging different data
sets (files)

Grid a 2D array of data points

Interpolation the process of estimating data at the vertex of a grid based on the
data collected at data points which are possibly randomly distributed



Importing Data
How to Import Data to QCTool

1. Select File/Import File. The Import Formats window appears, containing many formats:

 



2. Select a required format and click OK. In the Windows-style Import File dialog to open,
browse for the file to import.

QCTool permits import of the following data formats:

ASCII XYZ(.txt, .xyz)
ASCII CSV(.csv)
ASCII GEM
Binary XYZ
Geosoft GBN
Geosoft GDB
Scintrex CG3 Dump
Scintrex CG5 Dump(.dmp)
Scintrex IPR_12(.dmp, .raw)
Scintrex ENVI Cs/Navmag
Scintrex ENVI/ENVI PRO
SeaSPY(Marine Magnetics)(.mag)



Pico (.p*) files.
Geometrics G-858/G-859/G-856/G-882(.stn)
SEGY format
Stratagem impedance file
MT/CSAMT (impedance and spectral .EDI and .tbl formats)
VLF (.tbl format)
IRIS (VLF ASCII)
Universal Sounding Format(.usf)
Zonge AVG (legacy new and Zen formats)
Geonics (.asc, .m31, .g34, .g38 and TEM formats)
GEM triaxial bird
Geophysical logs (.las)
GPS Exchange Format(GPX)(.gpx)
Grid Exchange file (.gxf)
IAGA2002 Observatory Data
Micro-g LaCoste Air-Sea(.dat,.env)
GDD (IP, Current logger)
GSSI Profiler (.emi and .dat)
Phoenix (.avg, .strk and time series formats)
SMARTem25 (.raw, .stk)
EGR Grid Format
ArcGIS (.flt format)
Band Interleaved (.bil format)
CDED DEM
Geosoft grid file (.grd format)

3. Select the file to import and click Open. This brings up the Save As dialog, offering you
to save your file as a .qct file. You can leave the old name of your file or, if desired, rename
it.

4. Click OK to import.



ASCII Columnar Format

If you are importing the ASCII data, the Import: Set Channels dialog appears:

To specify the header line

If a file of data to be imported has a single-line header, the latter is automatically displayed
as a header in the Data Preview table. If your header is not automatically displayed
increase the number of skips until the header line shows in the File Header box.

If the initial header consists of two or more lines, each column in the Data Preview table is
assigned a consequent number (Ch1, Ch2 and so on), whereas the File Header field below
offers a number of choices.

Select a header line in the File Header field.



The standard delimiters between columns are a space, a comma, and a tab. If this is
the case, skip this paragraph and go to the next step. If you have a  different delimiter
in your initial file, click the Set Header Delimiters button to open the Delimiters
dialog. Check the Other box and specify the kind of the delimiter used in the now
active field to the right.

Double-click the selected header line to incorporate it into the table. A message asks
you to confirm the replacement.

Click OK to confirm.

If the File Header field does not contain any items, it means that the first line of the file to
import is not marked as a comment line (preceded by a slash "/"). In this case:

If you have one first line, select 1 from the Skip first rows dropdown list above the
Data Preview table. If you have two or more first lines, select the respective number.
This removes the first line(s) from the table and places it (them) in the File Header
field.

In File Header field, double-click a required line to insert it as a header in the Data
Preview table.

Click OK in the confirmation dialog to appear.

To specify the format of data to import

You can specify the format of each column of your data:

Select a column in the Data Preview table of the dialog. Note that the table contains
only a portion of the data to be imported (about 20 rows).

In the Column Format section:

Select the General Text button if a column contains text.

The box to the right shows an automatically estimated maximum number of
characters per row in this column. Since the estimation is based on the portion of data
displayed in the Data Preview table, you probably will want to edit it. For example,
your data set contains 10,000 points with record numbers from 1 to 10000. The Data
Preview table displays only 20 first rows with record numbers not exceeding 2
characters. As a result, the General Text box contains a 2-character estimate. To
provide for your 5-character data, change 2 to 5.



If your data contains date or time and you want to edit its format, click on the header
of the respective column, turn the Date or Time button on and select the required
format from the dropdown list.

Select Skip Column to remove a column from further processing. This option is
especially convenient when a column contains text and there is no point to subject it
to processing.

Select between the single- (4-byte) and double- (8-byte) precision and between a
short (2-byte) and long (4-byte) integer.

Repeat the same procedure for other columns.

Check the Use a Column as a Line Label box to have a separate table for each data
subset, or “line”.

It applies if every row of your initial data contains a line number. In this case all line numbers
are imported into a separate column. If you select Skip Column to remove it from the table,
QC Tool will still use information from this column to perform the subdivision by lines. Note.
Currently, this subdivision is possible only if lines in your initial file are identified by the word
“LINE”.

All above steps performed, click Continue to complete data import.

Note. The format adjustments will show only after import.



Binary XYZ Format

If you are importing the binary XYZ format, the Binary File Import dialog appears:

Specify the number of channels in a record in the box at the top of the dialog and click
Set.
If the file begins with data you do not want to import, enter a value in the edit box
labelled Number of initial bytes to skip
Selecting Big Endian in the Byte Order section indicates the file contains values
where the first byte is the most significant byte. If the most significant byte is the last
byte, choose Little Endian.

The table below and the Data Format section become active.

Click on the cell in the Name column of the table to enter the name of the channel and
on the cell in the Units column to enter the units of measurement.
In the Read Format section, select between the four options, 16-bit integer, 32-bit
integer, 32-bit float, and 64-bit float. The Write Format section changes accordingly.



Click Set for Selected to insert the data format in the selected row of the table

OR

Click Select All Channels to select the whole table and then Set for Selected to add
the same data format to all rows.

All channels having been specified, the File Records section in the bottom left-hand corner
of the dialog becomes active.

In this section, check the total number of records in your file and specify, if required, an
interval to be used to cut your data into lines.

In the Fiducial Channel section, leave the Fiducial Channel box checked to add this
channel to your table and insert the value of sampling frequency in the respective field.
This sampling frequency could represent any quantity to be used to number or order
the data. For example, if the sampling frequency were set to be 1 then the Fiducial
would simply be the record number. As pointed out in the Terms section, an important
purpose of this channel is to provide basis for merging different data sets.

Click Continue to complete data import.



Geosoft GBN file import

Select File/Import on the QCTool menu. The Import Formats dialog appears.

From this dialog, select Geosoft GBN and click OK. In the Import file dialog to
appear, browse for a required *.gbn file and click Open.

The standard Windows-style Save As dialog opens, offering you to save your *.gbn
file in the *.qct format.

Click OK.

The GBN File Import dialog that appears contains general information on your file -
the number of lines and the number of channels in a record. The left-hand table below
shows all the channels available in your file; the right-hand table shows all the lines
available in your file.



Select or deselect the channels to import in the Channels table. You can do it
manually by checking or clearing the boxes in the Exp column. Or, you can select one
or more channels at a time and use the Check Selection and Uncheck Selection
buttons in the right-hand part of the dialog.

To specify the output data format for an individual channel:
Click on a channel in the table, select one of the five available formats in the Output
Data Format section and click Set for Selected.

Select or deselect the lines to import in the Lines table. You can do it manually by
checking or clearing the boxes in the Exp column. Or, you can select one or more
channels at a time and use the Check Selection and Uncheck Selection buttons
under the table.

Check the Import Fiducial as a separate channel to create a channel for the
Geosoft file's fiducial column usually displayed as the first column.

The amount of data you have selected to import is displayed at the top of the window
beside GBN Data Size. This value needs to be less than the Maximum export size
in order to import your data.

Click Continue to complete import into QCTool.



Geosoft GDB file import

Select File/Import on the QCTool menu. The Import Formats dialog appears.

From this dialog, select Geosoft GDB and click OK. In the Import file dialog to
appear, browse for a *.gdb file and click Open.

The standard Windows-style Save As dialog opens, offering you to save your *.gdb file
in the *.qct format.

Click OK.

The GDB File Import dialog that appears contains general information on your file -
the number of lines, the number of channels and the total number of points. The left-
hand table below shows all the lines available in your file; the right-hand table shows all
the channels available in your file.



Select or deselect the channels to import in the Channels table. You can do it
manually by checking or clearing the boxes in the Exp column. Or, you can select one
or more channels at a time and use the Check Selection and Uncheck Selection
buttons in the right-hand part of the dialog.

To specify the output data format for each channel:
Click on a channel in the table, select one of the four available formats in the Channel
Data Type Setting section and click Change Data Type.

Select or deselect the lines to import in the Lines table. You can do it manually by
checking or clearing the boxes in the Exp column. Or, you can select one or more
channels at a time and use the Check Selection and Uncheck Selection buttons
under the table.



Check the Import Fiducial as a separate channel to create a channel for the Geosoft
file's fiducial column usually displayed as the first column.

Click Import to complete import into QCTool.



Scintrex CG3 Dump Format

On selecting Scintrex CG3 Dump in the Import Formats dialog (see How to Import Data),
the Scintrex CG3 Dump Import dialog appears:

In the Columns in File field, select columns that you want to import and click the 

button. The selected columns will appear in the Columns to Import field. To remove

a column from the Columns to Import field, select this column and click the 

button.

Select a required date and time format from the respective dropdown lists below. This

is how the date and time will appear in QCTool.

Leave the Sort All by Time Channel box selected to sort your data by time in

ascending order. If you de-select this box, you data will appear in the same order as

in the raw file.

Click Import.



SEGY Format

If you are importing using the SEGY format, after selecting the input and output files, the
SEGY File Import window appears:

Specify the channels you would like to import by selecting the box in the Check
column.
You may quickly Select All or Select None by clicking the respective button.
In the Traces to import section, you may specify how many traces you would like to
import from the file by entering a range from the First Trace to the Last Trace. It is
also possible to enter an Increment so traces will be skipped. e.g. A value of 1 will
import all traces. A value of 3 will import every third trace.



Working With Spreadsheets
Spreadsheets Overview

If a user imports a completed or an existing *.qct file opened, a spreadsheet-like “three-
dimensional” table appears containing data in the format you specified (see How to Import
Data to QCTool). This table has “depth” and can be divided into as many smaller tables as
the number of data subsets, or “lines”, in the initial file. They can be further subdivided
inside the application. You may also have a version that allows merging of these subsets or
“lines”. The links between the tables differ from those used in similar applications, like
Excel, since QCTool provides a very strict data structuring. The tables, numerous as they
may be in a file, all have the same data structure and, therefore, are easy to shuffle through
and to work within.

See Also

Change the Format of Data

Change the Colour and Font of your Spreadsheet

Copy and Paste Data in your Spreadsheet

Rename a Column Header

Insert a New Column

Delete/Restore a Column

Calculate/Recalculate a Channel, Create Row Indices

View the Channel Statistics

Delete a Single Value

Delete/Restore a Point (a Row)

Delete/Restore a Line (a Table)

Remove Outliers

Cut a Line into Two or More Parts



Rename a Line

Shift Position

Insert Points

Break Lines

Merge Lines

Print Selected Data



New command (File menu)

Use this command to create a new qct-file to be displayed in a new spreadsheet window.

Toolbar:

The following window will be launched. 4 new columns were added and the format of each
channel was selected

Add to the Columns list using the button with the red plus sign next to the list box.

Add to the Lines list.

Delete an entry using the appropriate  button.

Scroll through list boxes using the appropriate  and  buttons.



Click Create File, choose a filename and an empty spreadsheet will be displayed
according to the parameters you entered.

The resulting empty file can be edited by clicking on a cell and then pressing an arrow
key or enter to proceed to the next cell.



To change the format of data

Although you specified the format of your data during import or when you created a new
channel or imported a channel from another file, you may decide to change it during your
further work.You can easily do this right from the table.

Click on the header of the column, the format of which you want to change, and select

the Column Format button  in the second row of the QC toolbar that is available
when you work with spreadsheets

OR

Right-click on the column header and select Column Format from the popup menu to
appear.

The Channel properties window appears:

In the Data Display Format section of the dialog:



Select a required format from the dropdown list. For single- or double-precision data,
you have the Fixed and Scientific options. If your data represent Date or Time,
select one or the other from this list. This activates the Template Format menu
which, depending on your selection, will offer you various formats of date and time.

Specify the number of digits after the decimal point in the respective box.

Select the columns this format should apply to with a checkmark.

Click Apply.

Computing formula field contains the formula entered in the Formula Calculator function
for the currently selected channel. It cannot be edited here. To change it, use the Formula
Calculator interface.

To change name and units of the current channel, edit respective fields in the top left corner
of the window and click Apply.

During certain imports, some channels might be assigned an additional 'attribute' value. For
example, Geonics gate channels have "Middle of the gate period" stored in imported .qct
file. This string value can be seen and edited in the edit control to the right of Computing
formula box. In the screenshoot on this page, "Window center" is attribute name; "106.9
µs" - its value.

All changes become visible when you click Apply button. After editing is completed, click
Exit.



To change the colour and font of your
spreadsheet

In the top DOS type menu bar, select View/Spreadsheet Font on the QCTool menu. The
standard Font interface opens:

Make your adjustments as required and click OK. The changes will apply to the entire
spreadsheet. Being saved in your computer, the settings will remain the same even if you
switch to another line/data set or close QCTool and open it again.



To copy and paste data in your spreadsheet

The Copy and Paste functionalities are similar to those available in all like applications.

Select the cells/rows/columns you want to copy and click the Copy button  on the
QC toolbar or press Ctrl+C or select Copy on the right mouse menu.

Place the cursor where you want your data to appear and click the Paste button 
on the toolbar or press Ctrl+V or select Paste on the right mouse menu.



To rename a column header

Right-click on the header to change and select Column Properties from the popup
menu to appear.

Change the name and, if necessary, units in this dialog.

Click Apply.



To insert a new column

Right-click on the header of the column, next to which you want to create a new
column.

In the popup menu to appear, select Insert Channel. The Insert Channel dialog
opens:

In the Insert section, specify the location of a new column relative to the column
selected. 

In the Data Type section, specify the format of data this column will contain.

Specify the header of the column in the Channel Name box and the units of
measurement in the Channel Units box.



Click Insert.



To duplicate currently selected column

Right-click on the header of the column, next to which you want to create a new
column.

In the popup menu to appear, select Duplicate Channel. The Duplicate Channel
dialog opens:

In the "Result" section of the dialog, set desired type of newly created channel.

Click Insert.



To delete/restore a column

Right-click on the header of the column to delete.

In the popup menu to appear, select Delete Channel. The column will get highlighted
in dark blue, which means that it has been removed from processing.

To restore an earlier deleted column, right-click on its header to bring up the popup
menu and select Restore Channel.



To calculate/recalculate channels, create row
indices (Formula Calculator)

The Formula Calculator is used in the following cases:

When you need to recalculate values in a number of cells of a column
When you need to recalculate an entire column in one spreadsheet or all
spreadsheets
When you need to calculate a new column; in this case, prior to the calculation, insert
a new column as described in Insert a New Column
When you need to assign each row an index.

To bring up the Formula Calculator:

Select a required number of cells in the column or double-click on the header of this
column to select all the cells in it and click the Calculate Data button .

OR

Right-click on the selected cells/column/newly-added column and select Calculate
from the popup menu to appear. The Formula Calculator window opens:



In this window:

The Result dropdown list shows the index (a letter) of the column for the
calculated value to appear.

In the Formula section:

Work out your formula using the standard Functions and Numeric
keyboards below. The Columns keyboard inserts the indices (letters) of
the columns and is used if your formula is based on the values from other
channels.
Use the standard Delete button to edit your formula.
Click the Save button to save your formula as a .fml file, so that in future
you can use it again.
Click the Load button to load a .fml file and use an already available
formula.



Click the Clear button to remove or replace the formula.
Formulas are stored to the .qct file and if the user has performed
calculations previously, the formula may be loaded by clicking Load
channel formula
Click Check Formula to make sure that the formula contains no errors. In
the Formula Result section below, you will see a sample of calculation
for the first row or, if your formula is incorrect, an error message.

In the Rows section of the window:

Specify the range of rows in a new column to contain the calculated
parameter. If you have already selected a certain number of rows right in
the table, the From and To fields will contain the first and the last number
of these rows, respectively.
Check the All Rows box to select all rows. The From and To fields will
become disabled.
Check both the All Rows and All Lines boxes to select the same column
throughout all of your tables (lines)

Note. If you specify the first and the last row in the From and To fields
and simultaneously check the All Lines box, the number of the rows to
be selected in each table (line) will not exceed the range specified, no
matter how many more rows the table contains.

To create indices for the rows specified in the Rows section of the calculator:

Click row in the Functions section of the calculator if you want the
indices to reset with each new line.

Click frow if you want the indices to continue throughout all of the lines.

Click Apply and Exit to close the dialog and see the results.
The random button will generate a random number between 0 and 1.



To view the channel statistics

Select any group of cells in a given column.

Right-click on this group or on the column header and select Statistics from the popup
menu to appear.

OR

Click the  button in second row of the QC toolbar.



To create a channel for a statistics value

Click the Make channel button and select a statistics value, using the radio buttons that
appear
Click the Save button and select a name, format and insertion point for the new channel



To delete a single value

Right-click on the cell containing a value to delete and select Set Dummy Value from
the popup menu to appear.

This will replace the value by an asterisk and automatically remove it from further
processing.



To delete/restore a point (record, row)

Select the point/row/record you want to remove.

Click the Delete Point(s) button  on the QC toolbar

OR

Right-click on the point number in the first column and select Delete Point(s) from the
popup menu to appear.

The whole row will get highlighted in pink, and the  sign will appear in the first
column before the point number.

To restore a point, right-click on this sign and select Restore Point(s) from the popup
menu to appear.

Note. You cannot restore a point after you have closed your file and then opened it
again.



To delete/restore a line (a table/spreadsheet)

Click the Delete Line button  on the QC toolbar. The line you are currently in is removed
from the dropdown List of Lines on the main QC toolbar, whereas your spreadsheet
automatically switches to the next line.

However you can always restore the line you deleted:

Click the Line Info button  on the QC toolbar to open the window below:

In the List of Lines, you can see the  sign before the line you deleted.

Double-click this sign to restore the line.

Use Shift or Ctrl key to select lines. Delete/Restore Selected Lines is enabled automatically.
Click the button



The values in the Total Number of Lines and Total Number of Points boxes in the right
part of the dialog update accordingly to reflect the deletion or restoration of the line(s).

Note. You can also delete a line right in the Line Info dialog. Double-click on the line you
want to delete, and the  sign will appear to indicate that the line has been removed.



Click Set Names to generate line names for each line by entering a
Name Root and index preferences. For example, a Name Root of
"L", starting index of 0 and increment of 100 would result in line
names L0, L100, L200, etc.



To remove outliers

Right-click on the header of the channel and select Processing then Outlier
Removal from the popup menu to appear. The following window opens:

The Channel field contains the name of the channel you selected.

Check the Minimum and Maximum boxes and type in the limits. In this case, the
processing will apply to values either above the maximum or below the minimum.

You may specify the minimum and maximum as limits for a range of values to be
deleted by selecting Process values between maximum and minimum
Decimal digits displays the number significant digits that will be displayed after the
decimal point for Minimum, Maximum, and Standard Deviation.



In the Apply to section, select Current Line to remove outliers only from the line you
are currently working with and All Lines to remove outliers from all available lines.
You may also specify a range of rows. The default values are for all rows.

In the Outlier Points section, select Delete to remove the whole rows containing
outlier points. The rows highlighted in pink mean that the respective points have been
deleted.

Select Set Dummy Value to replace all the outliers in the column with asterisks and
thus remove them from processing. If later you want to delete the whole rows
containing the dummy values, check the Delete Points with Dummy Values box or
from the main menu select Processing/Delete Dummies. The rows highlighted in
pink mean that the respective points have been deleted.

Select Set Value to replace all the outliers with a specified value.
Select Add Value to add to the outliers

Note. To restore the points, select them in the record number column (N), right-click,
and choose Restore Point(s) from the popup menu to appear.

Click Apply.



Batch outlier removal
Right-click on the header of a channel and select Processing then
Batch Outlier Removal from the popup menu. The following
window opens:

You may select any number of lines or channels from the respective
boxes.

 selects all lines or channels for processing



 selects the currently highlighted items for processing

 removes the currently highlighted items from processing

 removes all lines or channels from processing

Specify the top and bottom limits according to percentage of
range from minimum to maximum. The minimum and maximum
values are calculated separately for each channel.
Check the box labelled Remove values between top and
bottom limits if you would like to define an outlier as between
the top and bottom limits instead of outside the limits
In the Outlier Points section, select Delete to remove the whole
rows containing outlier points. The rows highlighted in mauve
mean that the respective points have been deleted.
Select Set Dummy Value to replace all the outliers in the
channel with asterisks and thus remove them from processing. If
later you want to delete the whole rows containing the dummy
values, from the main menu select Processing/Delete
Dummies. The rows highlighted in mauve mean that the
respective points have been deleted.

Note. To restore the points, select them in the record number column
(N), right-click, and choose Restore Point(s) from the popup menu.



To cut a line into two or more parts

This operation may be performed from the spreadsheet, the
plotter or the grid

Select the point where you want to cut your line into two portions.

Click the Cut Line button  on the QC toolbar.

In the dropdown List of Lines, both portions retain the original number of the line,
with the second portion also having the extension “_1”. Normally you will rename the
new lines as desired.

Repeat these steps to make as many cuts as desired.



To rename a line

Click the Line Info button  . The respective dialog appears:

In this dialog, select the line to rename from the List of Lines.

Type a new name in the box to the right of the List of Lines and click the Set Name
button.



How to Insert data points to QCTool

Insert a Point

Click the  button on the QCTool toolbar which will insert a new record/point at the point
selected in the spreadsheet
or right click in the N column of the QC spreadsheet.

The menu provides means to add a single record or multiple
records either above or below the selected location.

Click the  button on QCTool toolbar or right click in the N column of the QC spreadsheet
and select the same icon.
The following interface appears:



Select all lines or current line
Choose the insert position
Input a number of insert records
Click OK to insert new rows



Print Selected data

Use this command to print only a portion of your data.

Click File -> Print Selection Area. The following window appears.

Specify in the Current Line Information whether the data for all profiles should be
printed or only the data for the current profile.

In the Rows and Columns sections, the range of rows and columns to be printed can
be specified. All rows and columns are selected by default.



In the Sheet Order section, select Over, then Down to have the next printed page to
continue from the last cell in the current row. Select Down, then Over to have the
next printed page continue from the last cell in the current column.

The Set Printer button brings up the the printer properties window.

Set the left, right, top and bottom margins with the Set Margins button.

Click Apply then select File->Print Preview or File->Print to see the results of the
settings you chose.



Break Lines

Click the Tools -> Lines -> Break Lines. The dialog appears.

Input a file name for saving the result

Select a data channel for breaking lines

The data will split according to the values in the chosen data channel

Select the “Sort the selected break” check box if you want to sort the names of the
lines



Merge Lines

Click the Tools -> Lines -> Merge Lines. The dialog appears.

Input a file name for saving the result

Use shift or ctrl key to select existing lines, click Merge 



Repeat if required
Click OK

Line names in right listbox allow in-place editing.



Plots and Grids

The QC Plot and QC Grid provide a graphical representation of your imported or processed
data. They facilitate preliminary estimation of your survey results and allow fast and efficient
detection of erroneous data. For your convenience, you can arrange your window (this
option is available from the Window menu) to simultaneously view your plot, grid, and the
respective table. Selecting any point in the plot or grid will automatically highlight its value in
the table.

See also

Working with Plots Working with Grids
Plot Data Grid Data
Switch Between Curves on the Same Plot Change to Another Channel
Set the Same Scale for All Channels Edit Data from the Grid
Display Plots by Segments Zoom In and Out
Switch Between Lines Zoom In on a Grid Fragment
Set a Channel as the X Axis Move Grid Elements

Adjust the X Axis Settings Measure the Distance Between Points

Edit Data from the Plot Interpolation
Zoom In on a Plot Fragment Grid Customization
Customize the Plot Appearance Calibrate a Map to Use as a Grid Underlay
Remove a Plotted Channel
Remove a Trend PRINTING GRIDS AND PLOTS

 



To plot data

Click on the header of the channel to be plotted and engage the Plot Data button 
on the main toolbar

OR

Right-click on the header and select Plot Channel from the popup menu to appear.

The plot is generated automatically. Below the main toolbar, the QCPlot toolbar appears: 

.

If your qctool files contains channels with associated time windows,
you may right click on an existing plot and select Plot Decay to
display a decay plot in a new window. See Set Time Channels to
assign time windows to channels.



To switch between curves on the same plot

You can select as many channels as you like and they all will be
displayed in different colors on the same plot. But you can view plots
of only one line (table/spreadsheet) at a time.
To switch between the curves (data channels):

Double-click on the curve you want to switch to
OR

Select the respective column in the table.

The y-axis labels will change their color to that of the curve you
switched to; the scale and units of measurements will also
change accordingly.



To set the same scale for all channels

Click the Panel Settings button  on the QC Plot toolbar.
The respective dialog appears:

·         Check Same Scale for All Channels and click OK. The Y-
axis turns black, which means that it has become general for all
the curves.

·         Note: to speed up loading of graphics, the plot automatically
splits in several segments if a large amount of data. If  you wish
to view all  segments, turn off the multiple segment display.

De-select this option in the Panel Settings dialog to return to
the initial view.



To display plots by segments

If your line has too many data points, it is often more convenient to plot it by segments.

Click the Panel Settings button  on the QC Plot toolbar. The respective dialog
appears:

In this dialog, check the Display Data by Segments box. The Total Number of
Segments box becomes active.

Specify the number of segments to divide your plot into and click OK. The plot will
display first segment by default.

To toggle through the segments, use the forward and back arrow buttons or select the
required segment from the Current Line Segment dropdown list on the QC Plot

toolbar: .



To display dummy values

Dummy values indicated in the spreadsheet by a '*' can be displayed in a plot. Any
dummy values will be set equal to the maximum value in the plot.

Click the Panel Settings button  on the QC Plot toolbar. The following
window appears:

Check the Display Dummy Values box and click OK.

De-select this option in the Panel Settings window to return to the initial
view.



To switch between
lines/tables/profiles/spreadsheets

Select a required line in the dropdown List of Lines on the main QC toolbar: 

.
 
The plot automatically switches to the line you selected.
Or click left/right arrows



To set a channel as the X-axis

Click the Change X Axis Channel button  on the QC Plot toolbar

OR

Double-click the X-axis label in the bottom right-hand corner of the plot.

The Set X Axis dialog opens:

Select a required channel in this dialog and click Set. The X-axis will change
to the scale of the selected channel. Its label will be replaced by the name of
the selected channel.



To adjust the X-axis settings

Select the Change X-axis Scaling button  on the QC Plot toolbar or double click
anywhere on the X-axis. The X Axis Settings dialog opens:

Edit the X-axis settings as needed in the active boxes of the dialog. These settings
include the maximum and minimum X values and the X-axis increment.

If you diminish Max X, the plot will go beyond the boundaries of the window and you
will see it only up to the point specified as Max; in this case, use the scroll bar in the



bottom of the window to scroll forward and view the entire plot.

Check Automatically change increment, the value of X-Axis Increment will be
calculated automatically and cannot be edited. Otherwise, the value of X-Axis
Increment is fixed

Select Keep axis settings for all profiles and the settings will not change when a
new profile is displayed

Specify the format of the axis labels in the Format section.

Click X Axis Font to select the font style and size of the X Axis labels.

Select Draw X Mesh Lines to display vertical dotted lines for the x axis. A similar
checkbox is available for the y axis.



To adjust the Y-axis settings

Select the Change Y-axis Scaling button  on the QC Plot toolbar or double click
anywhere on the Y-axis. The Y Axis Settings dialog opens:

Edit the Y-axis settings as needed in the active boxes of the dialog. These settings
include the maximum and minimum Y values and the Y-axis increment.

If you diminish Max Y, the plot will go beyond the boundaries of the window and you
will see it only up to the point specified as Max; in this case, use the scroll bar in the



bottom of the window to scroll forward and view the entire plot.

Check Automatically change increment, the value of Y-Axis Increment will be
calculated automatically and cannot be edited. Otherwise, the value of Y-Axis
Increment is fixed

Specify the format of the axis labels in the Format section.

Click Y Axis Font to select the font style and size of the Y Axis labels.

Select Draw X Mesh Lines to display vertical dotted lines for the x axis. A similar
checkbox is available for the y axis.



To set automatic Y axis scaling

Click the Y Axis Rescale button on the QC Plot toolbar

The y axis limits will be adjusted to match the visible minimum and maximum
values of the current channel.



To edit data right in the plot

If any error, your plot is distorted.

Click on the erroneous point.

To delete this point, click the Delete Point(s) button on the main QC
toolbar. Repeat it until your plot takes a normal shape.

To remove the whole line, click the Delete Line button . Your display will
automatically switch to the next line.

To split a line into parts, click the Cut Line button .

As a result, your line will be cut into 2 portions; with the first to be displayed by
default. To display its second portion, select it from the dropdown List of Lines on
the main QC toolbar: . It will have the same number as the first
one and the extension “_1”..



To zoom in on a plot fragment

Click the Zooming button on the QC Plot toolbar.

Click and drag to select the fragment you want to magnify.

To return to the initial view, click the Home View button on the QC Plot
toolbar.



To customize the plot appearance

Click the Change Plot Style button on the QC Plot toolbar to bring up the
Channel Style dialog:

Select the channel you want to change
the appearance of from the Channel
dropdown list.

Select Linear or Log in the Channel
Scale Mode section.

Click the coloured square on the right
to adjust the color using the standard
Windows-style palette.

Select the line style from the respective
dropdown list.

The Line Width option is applicable
only to Solid Line. Other styles do not
show on the plot unless the minimum
line width is selected.

Choose a required symbol from the
respective list and change its size using
the slider.

This functionality is especially useful
when you need to view the changes
you are making right in the plot. For
example, increasing the symbol size
allows you to pinpoint deleted points.

In the Sample field below, you can
simultaneously view an example of
your changes.



 



To remove a plotted channel

In the table, right-click on the header of the channel you want to
remove from your plot

and select the respective command from the popup menu
The channel will be removed from the plot.



To remove a trend

Your data may often be influenced by various factors and as a result contain trends
distorting its actual appearance. If it is the case:

Click the Linear Trend Removal button  on the QC Plot toolbar to bring up the
respective dialog:

The Processed Channel and Processed Line lists show the channel and line you
are currently working with. To switch to another channel and line, select them from
these two lists.

To remove a trend from all lines of data, check the Apply to all Lines box.

To remove a trend from the whole line, check the Apply to all Rows box in the Rows
section of the dialog.

To remove a trend from a certain portion of the line, specify the first and the last point
of this portion in the From and To boxes. You can either type in the values or do the
following:

1. Click in the From box. The  sign appears to the right, indicating that you are
about to insert a new value in this box (you will always find this sign next to the
boxes you are working with in the Rows or Trend Line Definition sections of
the dialog).



2. Click on the point of your curve which you want to be the starting point of trend
removal. The X coordinate of this point appears in the From box.

3. Click in the To box and then on the point of your curve which you want to be the
ending point of trend removal. The X coordinate of this point appears in the To
box.

To specify trend direction, enter the X and Y coordinates of the starting and ending
points of the trend in the Trend Line Definition section. You can either type in these
coordinates or insert them automatically by clicking on the respective points on the
plot.

Since the result will appear not only in the plotter but also in the respective
spreadsheet, select between the Overwrite and Create options in the Output
Channel section of the dialog. If you select Create, a new column will be added to
your spreadsheet containing the results of trend removal. If you choose the Overwrite
option, the box to the right will turn into a dropdown list, offering you to select the
channel to be replaced with a new one containing these results.

Click Apply.



To save a plot

Click the Save As button on the QC Plot toolbar or right click on the plot and select Raster
to File and follow the standard Save operations to create your file in a standard raster
image format.



To grid or map data

Mapping data displays all data points with a colour associated with
the values much like contours. This allows you to select a point and
it will be shown on the GRID tool with relevant information and
values.

Click on the header of the channel to be plotted and select the QC Grid button  on
the QC toolbar

OR

Right-click on the header and select Map Channel from the popup menu. The Set
Channel dialog appears:

Select a channel to use as the X coordinate from the X dropdown list.



Select a channel to use as the Y coordinate from the Y dropdown list.

If required, reselect a channel to grid from the Data dropdown list. The channel
selected by default is the one you specified in the table.

Check the X and Y - UTM coordinates box if you would like to display longitude and
latitude lines over your grid.

If the data set is very large then displaying every data point can be time consuming
and so if you select “Coarse grid” , a compressed version of the data will be
displayed.

Click Set.

Your grid is generated. Each data point in the resulting stack of lines is assigned its own
color. To see the value in a given point, click on the point and look its value up in the
respective table. To move across the grid, you can also use the arrow keys.



To change to another channel

The generated grid uses the channels you specified in the Set Channels dialog (see To
Grid Data). To change to another channel:

Select the  button on the QCGrid toolbar

OR

Click the button  on the QCGrid toolbar and click the Change Channel button 

.

OR

Right click the mouse on the new channel and select Map channel

The Set Channels window opens:

Reselect the channels in the X and Y dropdown lists.

Reselect the channel to grid in the Data dropdown list.



Click Set.

No matter which display you had – prior to or after interpolation, - your new display is not
interpolated.



To edit data right in the grid

There may be positional errors or data errors. You may desired to delete some points or
divide lines into two or more parts

Click on the erroneous point and use the Delete Point(s) button  to remove it
from the grid. Repeat this operation until your grid display becomes normal.

Use the Delete Line button  on the main QC toolbar to remove a whole line.

Click the Cut Line button  to cut a line into 2 or more portions.

In this case, your change does not show on the grid unless you zoom in on the
respective fragment (see To zoom in on a grid fragment). You can also check it up in
the List of Lines on the main QC toolbar, in the respective table or plot, or in the Line
Info dialog that opens by clicking the Line Info button .



To zoom in and out

Use the Zoom In  and Zoom Out  buttons on the QC Grid toolbar under the
main QC toolbar.



To zoom in on a grid fragment

Click the Zoom Selected  button on the toolbar. The cursor will change into a
magnifying glass.

Click and drag to select a fragment to be zoomed.

To return to the initial scale, select Home View  from the same toolbar.

Note. To change back to the arrow manipulator, select it from the toolbar .



To move grid elements

Select Move from the toolbar. The arrow cursor changes to the hand manipulator .

Click and drag labels, symbols and other objects to the place you need.

This functionality is especially useful when you need to customize the appearance of
your grid (see the Grid Customization section).

Note. To change back to the arrow manipulator, select it from the toolbar .



To measure the distance between different points

Select Distance from the toolbar. Your cursor changes to the ruler .

Click on the starting point and drag to the ending point.

Check the result in the Status Bar at the bottom of the window.

Note. After measuring a distance, the cursor automatically changes back to the arrow
manipulator.



To perform interpolation
During the interpolation process, QCTool interpolates data from data points onto a regular
(rectangular) grid. You can interpolate the whole grid or its portion. In the latter case, before
interpolation, zoom in on a required fragment as described in To zoom in on a grid fragment.

Click the Interpolate  button on the QC Grid toolbar or double click on the grid
and the Tools interface will open. Select Contour and then Interpolation

The Grid Settings dialog opens:

Choose the method of interpolation in the Method dropdown list.

By default, the Natural Neighbour option is selected. If desired, you can change it to
Minimum Curvature. This enables the Max Iterations box below, for you to type the
required number of iterations.



The software attempts to find the best center for interpolation and a default angle
based upon the direction of the survey lines. U,V are the grid vectors within the
rotated grid space

Edit the U Min, U Max, V Min and V Max settings as needed.

Increase or decrease dU and dV (length of the grid cell side) or nU and nV (number
of points) to provide higher or lower resolution.

Change the dU and dV values and click in the nU and nV fields: the latter is
recalculated automatically. You can reach the same effect by changing the nU and nV
values and clicking in the dU and dV fields.

Edit the grid angle to examine your display from a different perspective.

The grid has its own coordinate system (u,v) which is rotated from the coordinate
system (x,y) chosen for the 2D display. In the example here, the grid is aligned along
the x,y direction (angle = 0) and ‘u’ is parallel to ‘y’.

Edit, if necessary, the X and Y reference points in the respective boxes.

If you are not satisfied with your changes, click the Default button to change back to
the initial settings.

Check the Remove Extrapolated Points box and set a required spatial radius to
restrict the area of interpolation. For example, a spatial radius of 55 means that if
there are no data in the radius of 55 m around a given point – a grid cell center, – this
cell will be removed from interpolation.

Note. The interpolation process interpolates data onto the entire regular rectangular
grid. However parts of this grid, which are far away from the data, may be overly
extrapolated and thus should be removed for careful viewing.

Select between the slow and fast algorithms (slow is more accurate, but fast is almost
always sufficient).

Check the Remove Duplicate Points box to provide the respective operation.

Click Interpolate.



The interpolation process can take some time depending on such grid settings as the
number of initial points, grid dimensions or the interpolation method.

If you interpolated only a grid fragment:

After interpolation, select Home View from the QC Grid toolbar. You will see the
interpolated fragment stand out against the primary grid background.



Customization Dialogs and Menus

You can change the grid appearance using two methods:

Select the Show Plot Components dropdown menu  on the QC Grid toolbar
and toggle on or off various features

OR

Select a button on the QC Grid toolbar 

or right click in the grid window and select an item from the popup menu for the
advanced customization of your grid appearance.

Related topics:

Display and Customize Lines

Change the Draw Mode

Draw and Customize the Mesh Grid

Draw and Customize Contours

Display and Customize the Coordinate Grid

Display Longitudes and Latitudes over a UTM-Based Grid

Display a Grid Proportionally

Use a Map Underlay

Customize the Legend and Scale

Customize the Grid Layout



To display and customize lines

Click the  button on the QC Grid toolbar or right click in the grid window and select
Lines. The following interface appears:

Check the Draw button to switch lines on and off (or select Show Lines in the Show
Layers dropdown menu on the QC Grid toolbar).

To assign the same colour to all of the lines, leave the Different Colors box in the
Lines section unchecked. Select a required thickness of the lines from the respective
dropdown list and click on the color square to the right to bring up the standard color
palette.

To assign different colors to the lines, check the Different Colors box. Select a
required thickness from the respective dropdown list.



To change the shape and size of symbols (points) on your grid, check the Data
Symbols box. The Data Symbols section becomes active. Select the required shape
and size from the respective dropdown lists.

To display the labels (line numbers), check the Line Labels box. Select between the
four options below. The All button displays all labels, the Skip button – every second
label, the Start and End options – the labels at the beginning and at the end of lines.

To edit the font and style of the labels, click the Font button  in the bottom right-
hand corner of the dialog.

To display station labels, select the Station Labels box. Select the channel used to
obtain a label for each station.



To change the draw mode of your grid

Click the  button on the QC Grid toolbar or right click in the grid window and select Data.
The following interface appears:

Select Equal Range to assign different colors to equal ranges independently of the
number of points in each range or select Equal Weight to assign different colors to
different ranges covering the same number of points.

Specify the range of data to be displayed (75% of data are displayed by default) using
the sliders to the right of the Min Data and Max Data fields that show the absolute
minima and maxima of your data. Or, type in these values manually. Click Apply.

Click on the colored squares to the right to open the standard Windows-style palette
and to specify colors for the start and end of the data range.



Select Draw points with no data to see points with dummy values



To draw and customize the mesh grid

Click the button  on QC Grid toolbar The following interface appears:

Check Draw Mesh to see your grid cells filled with color (or Show Interpolated Grid
in the Show Layers dropdown menu on the QC Grid toolbar). This functionality is
accessible only if your data have been interpolated; if not, a message prompts you to

carry out interpolation. Click the Interpolate button  and follow the steps as
described in To perform interpolation.

The Draw Grid Symbols option displays each grid cell as a set of four data (vertices)
and assigns a certain color to each data dependending on its value.

The Draw Grid Cells option calculates the average of the data located in the vertices
of a grid cell. The cell is filled with the color assigned to this average value.



The Draw Cells around Grid Vertices option displays your grid as a set of cells
drawn around each grid vertex and filled with a certain color assigned to the data
value in the vertex.

If you selected the Draw Symbol button, select the shape and size of the symbols to
be used from the respective dropdown lists in the Symbol section of the dialog.

Select the way for the color to fill the cells (Draw Symbol, Draw Cells, Draw Cell
Around Vertex).

Check the Grid lines box to draw the mesh grid. This functionality is available only if
your data have been interpolated; if not, a message prompts you to carry out

interpolation. Click the Interpolate button  and follow the steps as described in To
perform interpolation.

Click the Load Grid from File button below to load an already available mesh grid.

Select the grid line thickness from the respective dropdown list and click on the
colored square to the right to specify the color.

Change the density of your grid as needed both in the X- and Y-directions in the Skip
Lines section.

Save your grid as an egr file to use it later with other data. You may also plot the
difference between the currently displayed grid and a grid that you load.

Resulting interpolated grids my be saved or loaded here. Also, you may create the
difference between grids here as well



To draw and customize a contour display

Click the button  on the QC Grid toolbar or the Contour tab on the Tools menu. The
following interface appears:

Check the Draw Contour Lines box to draw contours (=Show Contour in the Show
Layers dropdown list on the QC Grid toolbar). This functionality is accessible only if
your data have been interpolated; if not, a message prompts you to carry out

interpolation. Click the Interpolate button  and follow the steps as described in To
perform interpolation.

Check the Fill Contour box to display filled contours.

Select between the color and black representation of the contour lines and labels.



Choose the number of contour levels and line thickness from the respective dropdown
lists.

Check the Labels box to display the contour values and specify their format in the
respective section (fixed or exponential, the number of decimal digits).

Use the Density slider to increase or decrease the amount of labels to be displayed

and click the  button to adjust their font and style.



To display and customize the coordinate grid

Click the button  on the QCGrid toolbar or the Axes tab on the Tools gui. The dialog
appears.

Check the Major Lines and Minor Lines boxes in both the X-direction and Y-
direction sections to show the coordinate grid.

Adjust the minimum and maximum coordinates in the respective boxes to display the
portion of your grid you are primarily interested in.

Change the step between major ticks in the respective boxes to increase or decrease
the density of your coordinate grid.

Click the color square in the bottom right-hand corner of both sections to edit the color
using the standard Windows-style palette.



Select between the Top and Bottom positions of the labels in the X-direction section
and between the Left and Right positions in the Y-direction section.

Select the mode of outside and vertical positions of the labels in the X-direction
section and the Y-direction section

Input the number of Sub_Ticks of Minor lines in the X-direction section and the Y-
direction section

Click the  button to specify the font and style of the labels in the standard
Windows-style Font dialog.

Specify the number of decimal digits to be displayed in the respective box.

Click the Line Style of Lat/Lon to specify colour, font, line style and width for the
latitude and longitude display.

Note.To switch the coordinate grid off, de-select Major and Minor Lines or de-select Show
Coordinate Grid from the Change Layer dropdown list on the QC Grid toolbar.



Display latitudes and longitudes over a UTM grid

Select the  button on the QCGrid toolbar

OR

Click the button  on the QCGrid toolbar and click the Change Channel button 

.

The Set Channels window opens:

Check the X and Y - UTM Coordinates box and click Set.

Go to the Axes tab of the Tools dialog



and click the Lat/Long button. The Lat/Lon Settings dialog opens:

In this dialog:

Select between the W and E, N and S directions.

Specify the step in the respective boxes to the right.

Select a required ellipsoid from the respective list in the bottom of the dialog.

Click OK.

Back in the Axes tab, check the Longitude box in the X-direction section and the Latitude
box in the Y-direction section. Longitudes and latitudes will appear over your grid.



To display your grid proportionally

Go to the Lines tab of the Tools dialog.

Check the Proportional View button. The sides of your grid will become of equal
length.

OR

Click the proportional button 

Grids will be displayed proportionally by default if there are multiple profiles.



To underlay a map

Click the  button on the QC Grid toolbar The following interface appears:

Click the  button to display the Open Georeferenced File window. Select and load
a map.

There are a number of supported map file formats. They are PEGeoMap(.map), GeoTIFF,
AutoCAD(.dxf), ArcView World, MapInfo and Google Earth (.kml)

Note. See Calibrate a map. for instructions on how to create a .map file in
PEGeoMap

Loading a GeoTIFF file launches the following window that displays the geographic
information extracted from the file:



You may adjust the OrgX and OrgY GeoTIFF values to shift the map's location

Loading a DXF file enables edit boxes to specify the line width and resolution of the DXF
vector graphic

When loading a KML file you need to specify the type of coordinate and the current datum
as when exporting to KML

De-select the Draw Map box to remove the map.



To customize the legend and scale

Click the  button on the QC Grid toolbar or right click in the grid window and select
Legend. The following interface appears:

Check the Draw Legend box to display the legend (or select Legend in the Show
Layers dropdown menu on the QC Grid toolbar).

Specify the mode (vertical or horizontal)

Specify the format (fixed or exponential), the number of decimal digits, and font  for
the values in the legend.

To move the legend, click on the legend and move it in a desired direction with the
hand manipulator to appear.



Check the Scale box to authorize scale changes and bring up the scale rule.

Choose a required scale from the respective dropdown list and click Apply in the
upper right-hand corner of the dialog (or click anywhere in your plot) to view the
result. The scale rule will change accordingly.

Check the Draw North Arrow box in the bottom of the dialog to display an arrow
pointing north.



To customize the grid layout

Click the  button on the QC Grid toolbar The following interface appears:

Specify the margins around your grid display using the Left, Right, Top, and Bottom
scroll lists

Type in the titles, click the  button on the right to specify their font and style, and
click Apply in the upper right-hand corner of the tab.

Go the Legend tab:



Check the Draw Text box to add comments to your display.

Type in the field below, press Ctrl+Enter to insert a carriage return, click the 
 button to adjust the font and style of your labels and texts in the standard Windows-
style Font dialog.



To change the transparency of grid layers

First, a map will be loaded through the Map tab

Click the  button on the QC Grid toolbar or the Transparency tab
on the main Tools gui.
The following interface appears:

Select the checkbox related to the layer you would like to add
transparency

Adjust the appropriate slider to set the level of transparency. 0
will have no transparency. 100 will render the layer invisible.



In the Listing of Layers box you may drag the entries to put the
layers in a different order

Click Apply to see the effect of your selections



To save a grid in a map format

Click the Save View As button  on the QC Grid toolbar and follow the standard saving
operations. Or double click on map to open up the Tools gui and then select Map then
Save view as georeferenced raster

Select Raster Type

Select Raster Resolution

If the Raster with Georeferenced File option was chosen, three georeferenced file formats
are available to work with in PEGeoMap, ArcView and MapInfo respectively. Additional
positioning information must be specified for the MapInfo file. A MapInfo projection string is
required. One can be generated from the settings you have selected by clicking the Create



MapInfo projection string button.
MapInfo Projection String Details

When saving to GeoTIFF format, you will need to select a well-known coordinate system
and zone in this window:



If you are not using one of the systems listed, you should convert the coordinates first
before plotting and exporting to GeoTIFF

Other export options are available on the map tab.

Also, you can save legend (colour value scale) separately, and then insert it into printed
page if needed (see PEGeoMap PageLayout description). For this, right button click over
the legend, popup menu string "Save legend bar as raster" will appear.

NB: 
Note that when you save a grid which is not drawn as "proportional" (i.e., width and height
ratio does not reflect real topographic sizes), saved raster also will not be proportional.
However, obtained georeferenced image will be geographically correct. When read into
mapping software (PEGeoMap, ArcMap, GlobalMapper, etc.), it will be positioned
accordingly to its coordinates.



MapInfo Projection String

You can construct the string by entering the necessary values on the
interface and clicking the Create MapInfo projection string button.
Otherwise, find the string you need from another source and enter it
manually.

A complete table of projections and datum codes for MapInfo is in
the \BIN\MAPINFO\MAPINFO_CODES.TXT file supplied with your
installation. In the text file, you can find some strings by EPSG
number. The number is prefixed by '\p'. The header of the text file
describes how to create a proper CoordSys Earth Projection string
using the appropriate #MAPINFO line.



The Create MapInfo projection string button makes strings only for
UTM and geographic lat/long projection codes. For other projections,
you must type in the string manually.

When saving KML as .TAB, the string is created automatically as
WGS84 lat/long. If source map was a .TAB, the default string comes
from that source map.

Example MapInfo projection strings:
(UTM): CoordSys Earth Projection 8, 116, "m", 141, 0, 0.9996,

500000, 10000000 
where: 8 - UTM projection; 116 - GDA94 datum; m - units; 141 -
central meridian, 0 - latitude of origin;
0.9996 - UTM stretch coefficient; 500000- false easting; 10000000-
false northing (for Southern hemisphere; 0 for Northern).

(geographic): CoordSys Earth Projection 1, 104
where: 1 - geographic latitude/longitude; 104 - WGS84 datum.

(Lambert): CoordSys Earth Projection 3, 104, "m", 3, 46.5, 49, 44,
700000, 6600000
where: 3 - Lambert projection; 104 - WGS84 datum; m - units; 3 -
origin longitude; 46.5 - origin latitude;
49 and 44 - standard paralels; 700000- false easting; 6600000- false
northing.

-------- FREQUENTLY USED PROJECTION CODES: --------
1 - geographic lat/long; 8 - UTM; 10 - Global Mercator; 3 - Lambert
conformal conic.

-------- FREQUENTLY USED DATUM CODES: --------
104 - WGS84; 74 - NAD83; 116 - GDA94; 12 - AGD66.



To save to a georeferenced or vector format

Click the  button on the QC Grid toolbar to see the following interface

The grid image can be saved to Google Earth KML format by clicking the Raster to KML
button
Survey lines can saved to either Google Earth KML format or AutoCAD DXF format by
clicking the appropriate "Survey Lines" button. In addition, you can choose whether only
the line endpoints will be saved or at a specified interval:



When saving to KML format, this window will appear in order to convert the coordinates to
the WGS84 datum:

First specify whether your coordinates are UTM or geographic latitude/longitude. Next click
Select and you will have to choose the datum used for your current coordinates in the
following window:



You may display only the ellipsoids containing the text in the Filter by substring box by
clicking Apply. Display all ellipsoids by clicking Remove filters.
If converting from UTM coordinates, you will need to specify either the zone or central
meridian in this window:

 

Click OK on the main kml export window and the kml file will be created after you select a
file name, folder and image size.



Note that if you make 2 kml exports of the same data: raster overlay from QCGrid and
vector survey lines, and then open them both in GoogleEarth, they appear to be slightly
shifted against each other, especially when they cover comparatively large area (>10 km).
This is due to the fact that raster overlay has precisely positioned only its 4 corners, while in
vector survey lines each point is positioned in its exact geographic place.

Other export options are available by clicking the  button.



Printing Grids and Plots

To preview a grid/plot before printing:

Select Print Preview from the File menu.

Use the Next Page and Previous Page buttons on the Print Preview toolbar to toggle
through available pages.

Click the Two Pages button to preview two pages at a time, click it again to switch
back to the One Page mode.

Click the Zoom In button to take a closer look at your plot and the Zoom Out button to
move it away.

To close the Preview mode, click Close.

To modify a plot before printing:

Right-click on the plot and select Additional Formatting(This is not available for a
grid). The Print layout settings window appears:



In the Horizontal/Vertical grid lines section, you may select a new colour for the
respective grid line.

You may specify whether you would like X Tick labels at the Top, Bottom or both. As
well, Y Tick Labels can be displayed on the Left, Right or both. Tick labels can also
be displayed Inside the axis by selecting the respective checkbox.

You may change the X axis label or the Y axis label. Select the Channel name
checkbox to change back to the original channel name.

Select the Draw current location to display the cursor indicating the current location
on your printout.

To print a grid/plot:

Click Print in the preview mode to print the grid/plot right away.

You may also select Print from the File menu. In the standard Print dialog to open,
specify printing properties and click OK to start printing.



If you have selected items from the Print layout settings window, you need to right-click
on your plot and select Print Layout to see the effect of your selections. See Print
Layout for more information.



Print Layout

Right click on a grid/plot, select Print Layout and the following
window is displayed:

Moving and resizing page components can be done by use of
trackers. To activate the appropriate tracker, left-click on the
component.

To repaint the entire page and clear trackers, click the  button or
right-click anywhere in the window.



The application window size is calculated to match the aspect ratio of
the current printer page size. Changing the width of the application
window forces the window's aspect ratio to match that of the selected
paper size.

Scale If you are displaying a grid proportionally, you may choose to
have a scale on your hard copy. The scale is recalculated if the grid
changes size. To select a specific scale value, select Scale/Scale to
Value from the menu and enter the new value for the scale you would
like. Toggle scale visibility with the  button or by selecting
View/Scale in the menu. To change font of the scale, right click on it
and select Font.

Raster images
You may add pictures by clicking the  button or selecting
Options/Add raster image from the menu. Navigate to the location
of the raster image you would like to add then click on the location
where you would like the image to be. To retain aspect ratio when
resizing a raster image component, hold the Ctrl key while resizing or
right click and select Resize proportionally to width Delete the
image by right-clicking and selecting Delete

A logo is a special type of raster image. Its path is saved between
QCTool sessions. Toggle its visibility by clicking the  button or
selecting View/Logo from the menu. Select a logo by clicking the 
button or selection Options/Change Logo Image from the menu.

Text Boxes
You may add a text box by clicking the  button or selecting
Options/Add Text Block from the menu. Double click on the location
where you would like the text box to be and start entering your text.
Single click the text box to edit its contents later. To move/resize a
text block, right-click on it and select Move/Resize. To change font of
a text box, select your text, right click on it and select Font.

You may add a special text box by selecting View/Title Box from the
menu. A title box is a text box with a border and divided into sections.



Right click and select Edit to change its contents.

Delete both types of text boxes by right-clicking and selecting Delete.

Legend
For a plot click the  button to toggle the visibility of a legend or
select View/Legend from the menu.
For a grid click the  button to toggle the visibility of a legend or
select View/Palette from the menu.



What is PEGeoMap

PEGeoMap is a compact mapping software. It allows creation of georeferenced maps from
appropriate raster images; draw various objects on top of it; create layered maps with
transparent layers; perform conversions between commonly used image and mapping
formats. 

Georeference types supported by PEGeomap:

1. MAPINFO .tab
2. ESRI world files (.jgw, .bpw, .pgw, .tfw)
3. Petros mapping format .map
4. GoogleEarth ground overlay .kml
5. Geotiff - tiff format with georeference written inside image file.

Types 2, 3, and 4 are two item formats: raster + text georeference file. 
Georeferenced image can be then imported as underlying map into QCTool grid or
EMIGMA Survey Editor and GridPresentation.
Also, it can be used in any kind of mapping software accepting these formtas, such as
ARCMap, GlobalMapper, etc.



PEGeoMap

Using PEGeoMap

Pegeomap is a tool for working with georeferenced raster images. It
can either use existent georeferenced files compatible with various
other mapping software, or create a new one by the "Generate a
Map" procedure [see below]. A georeferenced image can be then
imported as an underlying map into QCTool grid or EMIGMA
GridPresentation and SurveyEditor.

PEGeoMap can be launched from the QCTool group on the windows
Start bar, from QCTool Grid toolbar, or started from Windows
Explorer.

Georeference types used in PEGeomap: MAPINFO tab, ESRI
world file, map, kml ground overlay - 2 items formats: raster + text
georeference file; 
geotiff - tiff format with georeference written inside image file.

To open a georeferenced map:
Select in menu File/Open geomap/ select georeference file: jgw,
bpw, pgw, tfw, map, tab, kml or geotiff. 
Or, it can be any kind of an image without georeference: bmp, jpg,
png, etc.; in this case, use File/Open Raster menu item.
Also, you can drag and drop any such file from Windows Explorer
into the application window.

If georeference was successfully discovered, status bar displays
valid X,Y coordinates; otherwise they are 0.

To Generate a Map (create georeference for raster image):

A raster format file (gif, jpg, etc.) needs to be loaded. If a file is
not already loaded you will be given the opportunity to load the



last used file. If you would like a different one, click No and a
window will appear offering you to select a file. You can also
load a raster file from the toolbar using the  button. You can
load a map file using the  button.
A raster file needs to be calibrated with at least three points.
Double-click on the first point in the image. The following
window appears:

Check the Polar box if your map comes from a polar region
Select the required ellipsoid datum from the respective
dropdown list
Specify the central meridian(CM) and zone in the respective
boxes
Select between UTM and Lon/Lat. The appropriate boxes
below will become active.

Type in the coordinates of the point to add and click Add Point.
Repeat this operation for the rest of the points.
To convert your UTM into Lat/Lon, select UTM, click Calculate
and the conversion appears in the Lat/Lon area. Select Lat/Lon
and Calculate to convert the other way. Lat/Lon will be



recalculated to UTM since raster transformation is based on
UTM coordinates.
Once at least three points have been entered, you may save
your map(see below) and the Map Tools will be enabled.

Managing the registered points:

Click the  button. The Edit Registered Points window will
open. Select the cell you want to edit and type in a new value.
Click the  button to remove all registered points.
Use the  button to apply a shift to the x and y values of the
map. The effect of the shift can be seen by looking at the X and
Y values displayed on the status bar located at the bottom of the
PEGeoMap window.

Customizing the appearance of the map:

To toggle the display of grid lines on the image display, click the 
 button.

To toggle between color and grayscale, click the  button
To add a line to your map, click the  button and draw the line
with the mouse. With the line selected:

Click the  button to change the line's width.
Click the  button to change the line's style.
Click the  button to change the line's colour.
Drag the boxes at the ends of the line to modify the start
and end positions.
Use the Map Tools to add a line at specific coordinates.

To add a symbol to your map, click the  button and drag the
mouse to specify the desired dimensions. With the symbol
selected:

Click the  button to change the symbol's style.
Click the  button to change the symbol's colour.



Drag one of the resize controls located around the symbol
to change its dimensions.
Use the Map Tools to add a symbol at specific coordinates.

To add an annotation to your map, click the  button. In the
Annotations window to open, write your text. Use the Font
section at the right end of the toolbar to change the appearance
of the text. Click on the map at point where you want the
annotation to appear and drag the mouse to specify its
dimensions.
To cancel any of the previous operations, click the Undo button 

Any items that have been added to the map can be repositioned
by dragging with the mouse.
A popup menu is also available by right clicking on the selected
item :

Delete - Deletes the item.
Edit - Displays the Annotation editing window.
Paste - Creates a duplicate of the selected item.
Properties - Display the window to edit the item's
properties.

Image rotation
If original image was obtained by scanner or drawn in skewed local
grid, for conversion to any of commonly used coordinates it might
need to be rotated.
To rotate an image, select Draw tools/Rotate and set required angle.
All point registering and drawings must be done after that.

Viewing the map:

To zoom in on your map, click the Zoom In  button on the
toolbar. Then, click on the image to the desired zoom level.



To zoom out, click the Zoom Out  button. Then, click on the
image until the desired zoom level is reached.
To zoom to a percentage of the actual size, click the down arrow

 and select a new zoom value.
To zoom to 100% of the actual image size, click the  button.
To move a different viewing area, click the  button and drag
the image with the mouse.
To measure a distance, click the  button and drag the mouse
between the two end points of the distance you would like
measure. The value of the distance will appear on the right end
of the status bar at the bottom of the PEGeoMap window. Three
points need to be registered in order to use this feature.

Saving your work:

Save using the  button. You may choose to save an image file
and/or a *.map file. The *.map file will be available to other
EMIGMA tools such as Grid Presentation and Survey Editor
which can use the created raster image as an underlay.
Click the  button to quickly save an image file only. Various
file types are supported.
To save a section of the image to a file, click the  button. Click
and drag the mouse on the image to create a selection box
containing the area you would like to save. Then, click the 
button to save the file.
To customize the layout of a printed hardcopy, click the 
button. The Print layout window will appear and then you will be
able to edit the appearance of your printout.

PEGeomap image layering: 

PEGeoMap can display 2 layers with selected transparency.

file:///C:/Users/conrad/AppData/Local/Temp/calibre_muhoqs/e68s4i_pdf_out/grid_presentation.htm
file:///C:/Users/conrad/AppData/Local/Temp/calibre_muhoqs/e68s4i_pdf_out/starting_survey_editor.htm


After loading your first map layer, select menu item "Map
Tools/Transparency". The Transparency of map files window
appears.
Select a 2nd layer map by clicking the "Map file2 - Browser"
button. 
Both layers must be georeferenced in the same coordinate
system.

Use the sliders to set the transparency as desired. Click Apply
to update the appearance of the image.

For successful saving of the layered image: 
Both layered images must have same raster type: bmp, jpg, etc.
(and correspondingly, bpw, jgw... world files if chosen format is
ESRI).

The resolution of 1st layer will be used for the saved image.
Generally, select an image with higher resolution for the first
layer.



Map Tools

These functions are available only when current image is
georeferenced: either originally, or by registering points.

PEGeomap image layering: 
PEGeoMap can display two map layers with selected transparency.

After loading your first map layer, select menu item
"MapTools/Transparency" or click the  toolbar button . The
Transparency of map files window appears.
Select the 2nd layer map by clicking the "Map file2 - Browser"
button. 
Both layers must be georeferenced in the same coordinate system.

 
Use the sliders to set the transparency as desired. Click Apply to
update the appearance of the image.

For successful saving of the layered image: 
Both layered images must have same raster type: bmp, jpg, etc.

(and correspondingly, bpw, jgw... world files if chosen format is



ESRI).

The resolution of 1st layer will be used for the saved image.
Generally, select an image with higher resolution for the first layer.

To see geographic coordinates:
Select from the menu Map Tools/Calculate Lat/Long. Select datum
and zone number. Then, the latitude and longitude of the current
cursor position will be displayed in the status bar.

Annotation Tools

Drawing positioned elements:
Click the  button to add a line to the map file. The following
window appears:



Use this window to specify the line dimensions, color and style.
Colors may be changed by clicking on the box labelled Color.
Click New add a new line to the map. Click Apply to modify an
existing selected line.

A similar window is used when adding a symbol to the map file using
the  button.

Click the  button to show the coordinates of an existing polygon.
The following window appears:

Use this window to display the coordinates for a polygon as well
as specify the line and fill color.
Select Fill with the color to specify a filled polygon.
Colors may be changed by clicking on a colored box.
Select Close Polygon to draw a line connecting the first and
last coordinates.



Select a pair of coordinates and press delete on the keyboard to
delete a point.
Click Apply to modify an existing selected polygon.
A polygon, symbol or line can also be modified by right clicking
on the object and selecting Properties.



Print Layout

To customize the layout of a printed hardcopy, click the  button and
the Print layout window will appear:

The default setting is Automatic which will print the map image
as displayed on the screen.
Deselect the Automatic checkbox to add additional items to your
printout. You can add a border, scale, information box, and logo.
Any of these items may be moved by clicking and dragging the
item on the Print layout window.
Edit the information box content by double clicking the box
labelled Info. Also, in this dialog you can select font and define



box metric size - its width in centimeters.

Edit the logo by double clicking the box labelled Logo. The Logo
Image window will appear:

Click the  button to browse for the logo image file.
You may change the size of the logo in the Scale section. Select
Lock aspect ratio to have one dimension update its value when
the other is modified so the image's aspect ratio is maintained.
The measurements of the logo on the printed page are shown in
the Image Physical Size section. The measurements can be
displayed in inches, centimetres or millimetres.



Click OK when finished.

You can insert multiple raster images into your page by clicking
"Insert image" button. After selecting a file, click page where you
want to place your image. Then, you can move images around the
page, and, by double click, change their sizes or delete. You can
insert colour scale legend bars saved in QCTool (described in "Save
a grid") or EMIGMA's GridPresentation.



To save a file

Select Save File from the File menu (you can also use the standard Save button on
the QC toolbar) to overwrite your old version.

Select Save As to create a new filename.



To save data in other formats

You can save your file in several formats: .qct (QCTool), .xyz (XYZ ASCII), .xls (Microsoft
Excel), .csv (comma separated values) and .gbn (Geosoft GBN):

Select File/Save As. The Save As dialog appears.

Select a required format from the Save as Type dropdown list and click Save. The
Export dialog opens.

In the Lines section of the
dialog:

Select a line you
want to export and

click the  button.
The line is moved to
the field on the right.

To export all lines,

click the  button.

To cancel export,

click the  and 
buttons.

Select between the
two options offered
for the line label
export: as a channel
or in a separate line.

Check the Export
Point ID as a
Channel box to



assign a special
number (ID) to each
row of your data and
to export such
numbers as a
separate column.

In the Channels section,
select the columns to
export in the Existing
Columns field and move
them to the field on the
right using the same
method as described for
the Lines section of the
dialog.

Click Export.

Note. If not indicated otherwise, the exported file will be saved with the same name, but a
different extension.



Managing Files

In certain cases, you may need to work with various files simultaneously. To facilitate this
task, the QC Tool offers its own File Manager.

If you work with one file, have to switch to another, but want the first one to be at hand:

Close all the files one by one.

In each case, a message will prompt you to click the Yes button if you want to close
your file and the No button if you want to hide it, i.e. “to put it aside for the time being”.

Click No and continue your work with other files.

When you want to open the file you hid, click the File Manager button  on the
main QC toolbar.

The respective dialog appears:

Select the file from the Files list and click Activate. The file will open.

You can also use the File Manager dialog to hide and close files:

To hide a file, select it from the Files list and click Hide.

To hide all the files, click Hide All.



To close a file, select it from the Files list and click Close.

Note. When you have a blank screen, click the ,  and  buttons on the main QC
toolbar. This will automatically restore the tables, plots and grids you hid last.



Coordinate Tools
Geographic Datum Conversion
To convert coordinates between two different datums, select
Tools/Coordinates/Geographic Datum Conversion to open the
following window:

In the Input Channels section:

Select the channels you want to convert from the dropdown lists.
The Lat and Long channels are recognized automatically.

Select the axis direction between W and E, N and S in
accordance with your data.



If longitude or latitude is negative, W and S are selected
automatically. Otherwise, you have to select the appropriate direction
yourself.

Standard sign convention is deselected to indicate that negative
values are opposite to the selected direction. e.g. -106W is the same
as 106E

In the Output Channels section:

You can leave the default header names offered by QCTool or
change them as desired. Select Insert before source columns
for the new columns to be inserted in that position otherwise they
will be inserted as the last columns.

To convert from UTM to Latitude/Longitude:

Click on the respective option in the upper left-hand section of
the dialog.

If grids are available, for more accurate results, you may make a
selection in the Grids available box and the checkbox for Grid
conversion will be selected.

Otherwise you may select the checkbox for Helmert conversion and
then select the Area, Source datum and Destination datum.

Click Convert to create the new channels



Transverse cylindrical projections
To convert between Latitude/Longitude and UTM using cylindrical
projections, select Tools/Coordinates/Geographic<->Projected
coordinates/Transverse cylindrical projections and the following
window opens:

In the Input Channels section:

Select the channels you want to convert from the dropdown lists.
The Lat and Long channels are recognized automatically.

Select the axis direction between W and E, N and S in
accordance with your data.

If longitude or latitude is negative, W and S are selected
automatically. Otherwise, you have to select the appropriate direction
yourself.



Standard sign convention is deselected to indicate that negative
values are opposite to the selected direction. e.g. -106W is the same
as 106E

In the Output Channels section:

You can leave the default header names offered by QCTool or
change them as desired. Select Insert before source columns
for the new columns to be inserted in that position otherwise they
will be inserted as the last columns.

Select the UTM World tab to use the cylindrical projection formula
defined in the document DMATM 8358.2 by the US Defense Mapping
Agency

Standard local projections contains projections for specific
locations in Europe and Africa and therefore will yield better results.
Most European projections in the list are Gauss-Kruger projections.
Otherwise, they are Mercator projections. Click the See info button
for more information and map for each entry. You might be required to
select the Zone for the projection you have selected.

Custom Mercator allows you to select the location of the natural
origin and false origin as well as the Scale factor at the natural
origin. Generic Mercator USGS formulas are used to calculate the
result.



Conic Projections
To convert between Latitude/Longitude and UTM using conic
projections, select Tools/Coordinates/Geographic<->Projected
coordinates/Conic projections and the following window opens:

In the Input Channels section:

Select the channels you want to convert from the dropdown lists.
The Lat and Long channels are recognized automatically.

Select the axis direction between W and E, N and S in
accordance with your data.

If longitude or latitude is negative, W and S are selected
automatically. Otherwise, you have to select the appropriate direction
yourself.



Standard sign convention is deselected to indicate that negative
values are opposite to the selected direction. e.g. -106W is the same
as 106E

In the Output Channels section:

You can leave the default header names offered by QCTool or
change them as desired.
Select Insert before source columns for the new columns to be
inserted in that position otherwise they will be inserted as the last
columns.

Select between American polyconic or Lambert conformal conic
projections

Specify ellipsoid and the location of the origin and false origin on the
tab you have selected. You may also specify a scale factor as well as
standard parallel for the Lambert Conformal Conic option.



Vertical datum conversion
Select Vertical datum conversion from the Tools/Coordinates
menu. The following window appears:

Input Channels Select the longitude channel in the combo box
labelled Long. West or East will be selected by default depending on
the sign of the longitude values.
Select the latitude channel in combo box labelled Lat. North or South
will be selected by default depending on the sign of the latitude
values.
Select the elevation channel in combo box labelled Elevation You
may apply the conversion to All Lines or only One Line 

Output Channels
The results can be saved to new channels by clicking the button
labelled Create. The names of the new channels will be the those
specified in the boxes above the Create button. New channels are
inserted after the elevation channel selected for input. To insert the
channels in a different location, select the Insert after checkbox and
the channel that the new channels should be inserted after.
You may also overwrite existing channels by selecting the button
labelled Overwrite. The channels that will be be overwritten can be



selected using the combo boxes above the Overwrite button. 

Datums that are supported are NGVD29, NAVD88, NAD83 and
WGS84. A conversion can be made between any two of these
datums. Select the Source datum and Destination datum in the
respective combo boxes. 

Click Convert to process the data.



Shift Coordinates [Lag]
In some cases, you need to shift your coordinates by the distance between
the receiver and the GPS station if, during the survey, they were located in
different places.

The algorithm determines the horizontal tangent to the instantaneous
position and adjusts forward or back according to the tangent vector.

Values in other channels can be updated to use the new shifted positions.

Select Shift Coordinates from the Tools/Coordinates menu. The Shift
Coordinates window appears.

Coordinate Channels
Select the input channels in this section. 

Shift Parameters



Specify the In-Line Distance in the related box. Select either the Behind or
Ahead options depending on the receiver position relative to the GPS
station. 

Output Channels
Select the names of the new output channels containing the shifted
coordinates when Create is selected. Select the channels to be overwritten
when Overwrite is selected. Channels selected elsewhere in this tool
cannot be selected to be overwritten. 

Channel Update
Select channels from the list box to the right if you would like them to be
associated with the shifted coordinates instead of the original coordinates.
This process requires that one of the original coordinate channels is sorted.
Specify which channel by selecting X or Y under the label Channels are
sorted by. This channel selection is enabled when a channel in the list box
is selected. If the distance from the shifted coordinates to the original
coordinates is less than the Resolution value, the updated value for the
selected channel will be placed on the same row of the original coordinates.
Otherwise, a new row will be created. New channels are created for the
updated values with names based on the original channel name and the shift
distance. 

Click the Shift button to shift the coordinates and to add the new data to the
spreadsheet.



Integrate Coordinate data into QCT file from
another file

The purpose of this operation is to integrate GPS measurements into QCT file.

Select menu item "Tools\Coordinates\Merge coordinates". The dialog appears.

Press "Select" button and choose file with GPS data.
Each point position is identified by "Line" and "Station" channels. Select these
channels for current .QCT file and selected Elevation file.
Select "Northing", "Easting" "Altitude" channels from GPS elevation file.
Click "OK" to execute..



Adjust Date/Time
Select Tools/Coordinates/Adjust Date / Time and the following window
opens allowing an shift in Time and/or Date

·  Select the channels for date and time at the top of the window and
example values from the first row appear in the boxes labelled Date Value
and Time Value
·  Select the Date Adjustment checkbox if you would like to shift the date,
Select the Time Adjustment checkbox if you would like to shift the time.
Select the Auto Date Adjustment to change both date and time channels
according to the changes in time. This means if the time value goes past
midnight, the related date value will be adjusted accordingly.
·  Specify how much you would like to add to or subtract from the date
and/or time then click Apply. The Undo button will then be enabled in case



you don't like the results.



Epoch Time Conversion

Epoch time is the number of seconds that have elapsed since January 1,
1970 at midnight UTC time. This tool will convert epoch time to a standard
date and UTC time.

Select Coordinates/Convert Epoch Time from the Tools menu. . The
following window appears:

Select the Epoch Time Channel in the drop down list at the top of the
window.
Select Create to place the output data in a new channels using the
entered names.
Select Overwrite to overwrite existing columns that can be selected in
the drop down lists.
Click the OK button when all the settings are correct.



Convert Julian Date

This tool will convert a Julian value for a year to a date in the format
YYYY/MM/DD. The Julian values can be within the range between 1 and
366 inclusive. Any values that cannot be converted to a date will be
displayed as an asterisk.

Select Tools/Coordinate/Convert Julian Date from the menu. The
Convert Julian Date window appears:

Select the channel whose values you would like to convert in the selection
box labelled Julian Date Channel

Specify the year that these Julian dates apply to in the Year box.

Select name for the new channel containing the converted date in the
Output Channel Name box.

Click OK to create the new channel



Split Date/Time

This tool will split a date channel into year, month and day channels. For a
time channel it will be split into hour, minute and second channels.

Select Tools|Coordinates|Split Date/Time from the menu. The Split
Date/Time window appears:

Input Channels Select channels for Date and Time. Deselect the
appropriate checkbox if you only want to split only one channel. At least
one channel needs to be selected.

Output Channels
Using the checkboxes, select the channels that you would like to output.



Select Overwrite to put the output in existing channels. Select Create to
create new channels for the output.



Create Uniformly Sampled

Data is often not collected uniformly sampled either
spatially or in time. For some purposes, filtering is
required to be used with uniformly sampled data. An
example is DFT filtering or spectral analyses.

Select Coordinates/Create Uniformly Sampled from the Tools menu. .
The following window appears:

Select two channels for the Coordinate Channel and Data Channel
Which will be modified so that the sampling rate of the values will be
constant. The name of the resulting channel will be the name entered
for Uniformly Sampled Channel.

A cubic spline algorithm is used to interpolate new values at the
uniformly sampled coordinates based on the values in the Data



Channel. The result is saved in a column using the name entered for
Interpolated Data Channel.
Select Alternate Interpolation to use a different mathematical version
of a cubic spline interpolation.
Click the OK button to create the new channels.



Interpolating Data

This functionality is accessible only if your data contains a base channel (e.g. Fiducial)
which may be both in an ascending and descending order. Interpolation is especially useful
when you merge two or more files and there are a lot of missing data as a result. You can
also use it to replace existing data that you consider doubtful by interpolated. In this case,
select these data, right-click on them, and choose Set Dummy Values from the popup
menu to appear. This will substitute your data with asterisks.

Select Tools/Data Channels/Interpolate Channels. The Channel Interpolation
dialog appears:

Choose the base channel from the dropdown list in the upper section. If your data
contain the Fiducial channel, it is selected by default. To use the record number N as
a base channel, check the respective box.

Select the channel(s) for interpolation from the list below.

Check the For All Lines box to interpolate data in all lines. This box unchecked, your
data are interpolated only within the line you are currently working with.

If you checked the For All Lines box, select Each line separately if you want
interpolation to be line-specific and Through the file if you want it to be continuous,
throughout all of the lines.

Click Interpolate.



Sorting by Channel

To sort your data by channel:

Select Tools/Data Channels/Sort All by Channel. In the dialog to appear:

Select the channel to sort your data by from the Sort by dropdown list and specify the
Ascending or Descending order on the right.

To specify the secondary sort order of your data, check the Then by box. The section
below is activated. Select the channel to sort by from the dropdown list and specify
the Ascending or Descending order on the right.

In the bottom Apply section, select For all Lines to sort your data by the specified
channel throughout all of the lines and For the current Line only to sort data within
the line you are currently working with.

Click Sort.



Integral
Select the channel you would like to work with by clicking the
channel name on the spreadsheet. Select Tools/Data
Channels/Integrals and Derivatives then Integral and the following
window opens:

Specify the new channel name and whether you would like the new
channel to appear before or after the current channel.

Select the whether you would like the new channel to be integer,
double or float in the Data type section

Select whether you would like to calculate integrals for only the
current line or all lines in the Apply to section.



Click the Insert button and a new channel will be created.
The value in row n in the new channel will be the sum of all the
values from the selected channel in rows 1 to n



Derivative
Select the channel you would like to work with by clicking the
channel name on the spreadsheet. Select Tools/Data
Channels/Integrals and Derivatives then First Derivative and the
following window opens:

A Second Derivative option is also available but without any
first order formulas
Specify the new channel name and whether you would like the
new channel to appear before or after the current channel.



Select the whether you would like the new channel to be integer,
double or float in the Data type section
Select whether you would like to calculate integrals for only the
current line or all lines in the Apply to section.
Click the Insert button and a new channel will be created.

Below are the formulas used to calculate the derivatives depending
the selection made. Values in initial or ending rows may not be
calculated.

First order forward difference
f'(x): f(x+1)-f(x)

First order backward difference
f'(x): f(x)-f(x-1)

Second order forward difference
f'(x): {-3f(x)+4f(x+1)-f(x+2)}/2
f"(x): 2f(x)-5f(x+1)+4f(x+2)-f(x+3)

Second order central difference
f'(x): {f(x+1)-f(x-1)}/2
f"(x): f(x+1)-2f(x)+f(x-1)

Second order backward difference
f'(x): {3f(x)-4f(x-1)+f(x-2)}/2
f"(x): 2f(x)-5f(x-1)+4f(x-2)-f(x-3)

Fourth order central difference
f'(x): {-f(x+2)+8f(x+1)-8f(x-1)+f(x-2)}/12
f"(x): {-f(x+2)+16f(x+1)-30f(x)+16f(x-1)-f(x-2)}/12



Vector Rotation

Rotate a 2D vector in the plane

Select the channel you would like to work with by clicking the
channel name on the spreadsheet. Select Data Channels/Rotate
Vector from the Tools menu. . The following window opens:

Select the channels for the x and y components of the vectors to
be rotated in the Input channels section.
The Output channels section enables the names of the result
columns to be selected as well as their insert point on the
spreadsheet.
The rotation angle can either be a Fixed angle or multiple
angles in the channel selected below Angle from channel.
Units for the rotation can either be degress or millradians,
selected in the Angle Unit box.



The direction of the rotation can be selected with the controls
labelled Rotation direction.
The Rows section of the interface is used to specify which rows
and lines should be processed. A range of rows can be
selected. Either the current line or all lines can be selected as
well.
Click the Process button to rotate the vectors and new channels
will be created.



Matrix Rotation

Rotate a 2x2 matrix

Select the channel you would like to work with by clicking the
channel name on the spreadsheet. Select Data Channels/Rotate
Matrix from the Tools menu. . The following window appears:

Select the channels for the elements of the matrix in the
Channels for input matrix section.
The names of the result columns can be selected in the Output
channels section.
The rotation angle can either be a Fixed angle or multiple
angles in the channel selected below Angle from channel. The
units must be in degrees.
If the names selected for the output channels already exist, the
existing channels can be overwritten by selecting the Overwrite



output channel checkbox. If the channels do not exist or the
checkbox is not selected, new channels will be created.
The Rows section of the interface is used to specify which rows
and lines should be processed. A range of rows can be
selected. Either the current line or all lines can be selected as
well.
Click the Process button to rotate the matrix.



Borehole\Ground TEM

This tool creates a qct file that can imported as Geonics data into
EMIGMA

Start with a file that has TEM data arranged in columns according to
time window. All time window channels need to be contiguous on the
spreadsheet. Coordinate channels are also required in the qct file
when importing to EMIGMA.

Select Data Channels|Borehole\Ground TEM from the Tools
menu. . The following window appears:

Select the channel for the First time window and enter the
number of time window channels in the file in the box labelled
Number of time windows.
The possible system types are fixed(ground), moving and
borehole.



Enter the values for the system parameters then click OK to add
the channels necessary to create a Geonics TEM file.
Time window start and end times depend on the base frequency
that was entered so the base frequency value needs to be one
that corresponds to a Geonics TEM instrument.



Square Wave

This tool creates a square waveform

Select Data Channels/Square Wave from the Tools menu. . The
following window appears:

The Frequency, Period, Sample Rate and Points per Cycle can
be specified in the Waveform Settings section. Changing one
of these settings will update the others. You may also specify
the Amplitude and On-time Percentage in this section.
The name of the result column can be selected in the Output
Channels section. Also, the data type and number of decimal
digits can be specified here.
Click OK to create the square wave.



Shift Records

Values in a channel can be shifted by a number of records.

Select Tools/Data Channels/Shift Records from the menu. The
Shift Records window appears:

Select the channel whose values you would like to shift in the
selection box labelled Current Channel

Specify the number of records you would like to shift the values in
the Shift Parameters. The values can be shift either up or down by
selecting Behind or Ahead respectively. If the values are shifted
down, dummy data will inserted in the new cells that appear at the
top. Dummy data will be inserted at the bottom if the values are
shifted up.

Output Channels Select Overwrite to put the shifted values in an
existing channel. Select Create to create a new channel with the



specified name for the result.



Fill Character Channel
Select the channel you would like to work with by clicking the
channel name on the spreadsheet. Select Tools/Data Channels/Fill
Character Channel and the following window opens:

Enter the text that you would like to save to the character
channel in the box labelled New Text
In the Apply to section, selecting All Lines insert the new text
in all lines of the channel or else only the current line will be
affected. The new text will be inserted in the range specified by
From Row and To Row unless All Records is selected and
then every row will be affected.
You may change the current channel by clicking a new channel
on the spreadsheet.
You may change the current line by selecting a new line on the
toolbar.
Click the Apply button and a new channel will be created.



Line Trends
This tool will calculate certain trends in the data on each line or profile.
Included are the Mean and Median for each line for the selected channel.
Also, a Linear Trend or linear fit to the data for each line can be calculated.

Select Tools/Data Channels/Line Trends from the main menu to display
the following interface:

 
·  You may choose to calculate Mean, Median and/or the Linear trend by
clicking the appropriate checkbox(es).
·  The names of the newly created channels containing the processed data
can be edited in the boxes below  Output Channel Names.
·  Click Process when you are ready to create the new channels.



IGRF Calculator

Select Processing/Magnetic Data Processing/IGRF Calculator to open the following
window:

To create IGRF channels, in the Input Channels section:



Select the channels you want to convert from the dropdown lists. The Latitude and
Longitude channels should be recognized automatically.

Select between N and S in accordance with your latitude

The world standard for longitude is that positive longitude is east from Greenwich
(Central Meridian) and thus a negative is west. The default setting is thus (E)ast.
However, it is quite common particularly in the United States to use a positive
longitude to represent west from the Central Meridian. If your longitudes are positive
and mean west, then select (W)est.

Specify the Height of sea level by selecting the channel which provides this information
from the respective dropdown list. You can also select Value and enter a height in the
respective box if you do not have an elevation channel.

Make sure that the date and coordinate frame information is correct.

In the Model section, you may select between the World Magnetic Model
(WMM2015) or the International Geomagnetic Reference Field model (IGRF12).
WMM2015 is only available for years between 2015 and 2019 inclusive. IGRF12 is
available for years between 1940 and 2019 inclusive

In the Output Channels section:

Select Overwrite if you want to replace existing columns in your table. The
inclination, declination, and intensity boxes turn into dropdown lists. Choose the
columns to overwrite from these lists.

Select Create if you want the results of your conversion to appear in new columns.
You can leave the default header names offered by QCTool or change them as
desired.

Select Insert after current channel if you want your created channels to appear after
the currently selected channel. The new channels will appear after the last channel
otherwise.

Click Calculate.



Derivatives By FFT

This facility produces spatial derivatives of data via FFT procedures.
It can be utilized with any type of data but theoretically it is intended
for either magnetic or gravity data. The technique requires
interpolation of the Input Data channel onto a grid which 2Nu x 2Nv in
size.

Note: Our gridding techniques do not require square grid cells and
thus the inline resolution ( in this example, 2.42m) and the crossline
resolution (200.16 in this example) do not need to be compromised.

Click the Processing -> Gravity/Magnetic data Processing -> Derivatives by FFT. The dialog
appears.



Select a data channel in the Input Data Channel section. 

Select data channels for coordinates

Click the ADV button to enable the Output Grid Information section.

Click Apply to calculate



Gradient Removal

This tool removes a linear trend from your data. It is primarily
intended for magnetic data to remove strong linear effects in the
regional response.

Select Gradient removal from the Processing/Magnetic Data
Processing menu. The following window appears:

Select the easting channel in the combo box labelled X channel.
Select the northing channel in combo box labelled Y channel.
Select the channel with the data that has the linear trend you want
removed in the combo box labelled Data channel.

The results of the gradient removal will be saved in new channel
using the name of the original Data channel. A suffix is added to the
name of the original channel to obtain the name of the new channel.
E.g. if the original channel was named "TMI", the new channel would
be named "TMI_NoGradient". The new channel is inserted directly
after the original channel.



Magnetic Compensation
Select Magnetic Compensation from the Processing/Magnetic
Data Processing menu. The Magnetic Compensation window
appears.

If the coefficients are calculated utilizing the fluxgate data then select
Fluxgate Data or otherwise select channels for yaw, pitch and roll by
selecting Aircraft Manoeuvres. Select channels for the x and y
coordinates in the UTM Coordinates section.

Sensor Data Specify the number of sensors in the box labeled Total
number of sensors. You may select the channels for up to 10
sensors directly below.

Recover Data Average
Select the checkbox to correct the DC level to that of the original data
line.



Coefficients
Click the Load Coefficient File button to specify the path of your
coefficient file. The file can be created by using the Compensation
Coefficient tool. The coefficients used for compensation has the angle
closest to the line being compensated. The compensated data with
the lowest figure of merit can be output instead by selecting the
checkbox labelled Search for the best box data line.

Output Channel
The compensation results will be saved in a channel with the name
entered here. If more than one sensor was specified the name of the
sensor channel will be appended to the name entered here.

Click the Calculate button to perform the magnetic compensation.



Create Magnetic Compensation
Coefficients
Select Create Magnetic Compensation Coefficients from the
Processing/Magnetic Data Processing menu. The Compensation
Coefficient window appears.

The coefficients can be derived in the traditional manner by using 3 fluxgate
sensors or they may be calculated by any set of data that provides
orientation. You may select channels for the components of the fluxgate data
by selecting Fluxgate Data or you may select channels for yaw, pitch and
roll by selecting Aircraft Manoeuvres. Select channels for the x and y
coordinates in the UTM Coordinates section.



Sensor Data Specify the number of sensors in the box labeled Total
number of sensors. You may select the channels for up to 10 sensors
directly below.

Parameters
The Parameters button is enabled when using fluxgate data. Click it to
select the number of terms to use when performing singular value
decomposition. The number of terms can be determined automatically by the
software instead if you select the Optimum parameters checkbox.

Click the Select Lines button if you do not want to calculate coefficients for
all the lines.

Click the Create Coefficient File button to create and save the coefficient
file that will be used when performing magnetic compensation.



Tie Line Leveling

When you have tie lines in your survey, you may use tie line leveling. This
algorithm attempts to adjust the data so that data points which are at an
intersection have a small a difference between them as possible. This is
done by applying corrections between the intersecting points.

Select Processing/Magnetic Data Processing/Tie line leveling from the
menu. The Tie line leveling window appears:

Channel Selection Select channels for Data, X (easting) and Y(northing).
The Z (altimeter or GPSZ) channel only needs to be selected if the
Auxiliary intersection file generation checkbox is selected.

Line Selection
Select Lines to be leveled by selecting entries in the Lines box and clicking
the button with an arrow pointing at the Lines to be leveled box. Select Tie
Lines by clicking the button with an arrow pointing at the Tie Lines box.
Lines can be removed from the Lines to be leveled or Tie Lines boxes by



clicking on the respective button with an arrow pointing at the Lines box.
The resulting output will correct on the Lines and not the Tie Lines.

Linearly Line By Line
This algorithm splits the lines at each intersection and uses linear
interpolation. For this algorithm, a line should have at least two tie lines that
intersect with it for it to be processed. If a line has less than two
intersections, its existing data will be simply copied to the output channel.

Correction of Systematic Error
This algorithm makes the data adjustment simultaneously utilizing all the
lines and tie lines to minimize the data errors at the intersection points. The
data errors are represented at the intersection points with a polynomial of a
particular order. The Order edit box displays the order of the polynomial. It
is only enabled for this algorithm. The order value needs to satisfy the
following to be accepted: 
(order+1)*(# of lines + # of tie lines) <= # of intersection points

Select Auxiliary intersection file generation to create a qct file that lists
the locations of the intersections as well as the data values of the two lines
at those intersections.



Gradient Calculation
The purpose of this function is to calculate the gradients between
multiple sensors. For example, the derivatives or gradients between
multiple TMI or vector magnetic sensors. These gradients are
calculated in the frame of the moving system. For example, if it is a
3-sensor bird to be towed by a helicopter, then this calculates the
gradients in the bird reference frame. Later, these gradients may be
de-rotated into grid coordinates or geographic coordinates.

Select Gradient Calculation from the Processing/Magnetic Data
Processing menu. The following window appears.



Number of Sensors Total number of magnetic sensors in the
system. Default is 4.

Relative Sensor Position
Coordinates are relative to the aircraft's natural axes for the selected
sensor. The origin is at the forward tip of the bird. The index of the
selected sensor is displayed beside the label Sensor.

Data



Channel containing the total field data for the selected sensor

The parameters for each sensor must be entered individually. Click
the left or right arrow button at the top of the Sensor Settings
section to display and edit the settings for a different sensor. If the
sensors are determined to have coordinates that are coplanar the
Aircraft Maneuvers and Measurement Location sections will be
enabled so a third gradient can be calculated.

Aircraft Maneuvers
Channels may be selected for Pitch, Roll and Yaw. Select the
checkbox in top left corner of this section to do this. Units are in
degrees.

Heading
Select Heading calculated from profile to indicate that the heading
will be computed from the profile then added to the yaw.
Select Heading included in yaw when assuming the heading is
included in yaw and additional calculations to determine the heading
are not needed.

Measurement Location
Select the channels indicating the x, y, z coordinates where the data
was measured.

Output Gradient Channels
Three components of the total field will be saved to the qct file.
Select Create to save the results in new channels with the selected
names. Select Overwrite to save the results to existing channels.

Click the Process button to calculate the gradients. The results can
be further processed by selecting Vector Derotation in the main
menu.



Vector Derotation
This de-rotation function projects data onto a specified coordinate
system. This assumes the vector data are with regard to a rigid
frame. Thus, this can be applied to gradients of multiple total field
sensors or components of the magnetic field (e.g. 3 component
fluxgates).

Select Vector Derotation from the Processing/Magnetic Data
Processing menu. The following window appears:



Input Channels Select the channels for the longitudinal, transverse
and vertical components of the vector that will be derotated. These
channels can be calculated by selecting Gradient Calculation from
the main menu.

Aircraft Maneuvers
Channels may be selected for Pitch, Roll and Yaw. Select the
checkbox in top left corner of this section to do this. Units are in
degrees.



Derotation Coordinate System
Select Grid to project the data on a grid specified by a Grid Angle in
degrees measured counter clockwise from east.
The data can also be projected on either an Absolute or Horizontal
coordinate system. The x-axis will be along the profile if Horizontal
is selected.

Heading
Select Heading calculated from profile to indicate that the heading
will be computed from the profile then added to the yaw.
Select Heading included in yaw when assuming the heading is
included in yaw and additional calculations to determine the heading
are not needed.

Measurement Location
Select the channels indicating the x, y, z coordinates where the data
was measured.

Output Gradient Channels
Three components of the total field will be saved to the qct file.
Select Create to save the results in new channels with the selected
names. Select Overwrite to save the results to existing channels

Click the Process button to perform the derotation.



Calculate Figure of Merit

This function is a means to evaluate magnetic
compensation results
Select Figure of Merit from the Processing/Magnetic Data Processing
menu. The Figure of Merit window appears.  This is normally done before
and after magnetic compensation.

Select the input channel with the box beside the label Magnetic Data
Channel. Normally this is done once with the original data and once with
the compensated data.

Edit the name of the output channel in the box beside the label Figure of
Merit Channel if you would like to save the results in a new channel.
Otherwise, select Overwrite and select the channel you would like to
overwrite. The FOM is calculated for each line of data. 

Click the OK button to calculate the figure of merit.

If you would like to have the ratio of FOM from correction to original, then



process the FOM separately for both original and corrected.
Create a new channel and then use the calculator to produce the ratio.



Reduce To Pole

You may convert the magnetic data you have to the magnetic field
that is at the north pole. What this really means is that the magnetic
data is modified to a source field which is perfectly downward as
would be the case at the magnetic pole.

Select Processing/Magnetic Data Processing/Reduce To Pole
from the menu. The Reduce To Pole window appears:

Input ChannelsSelect channels for Easting, Northing and Data.
Latitude, Longitude and Elevation channels as well as the date are
only required to calculate the default Inclination, Declination and
Intensity values. Click Update IGRF to update the values after you



selected a new channel or changed the date. Elevation is the height
above sea level in metres.

Output Channel
Select Overwrite to put the output data in an existing channel. Select
Create to create a new channel using the specified name.

Click Process to start the calculation. The calculation is performed
using a regular grid that must be specified using the Derivatives by
FFT tool that is automatically displayed.

Once complete, the gridded data is interpolated to the original
locations and saved in the specified channel. You have the option to
save the gridded data as egr files with suffixes added to the file
names as follows:
dat - magnetic data dx - dx derivative of magnetic data dy - dy



derivative of magnetic data dx - dz derivative of magnetic data rtp -
magnetic data reduced to the pole



Merge Base Station Data

You may merge columns from one file containing base station data
to another file.

Select Processing/Magnetic Data Processing/Merge Base
Station Data from the menu. The following window appears:

In the Survey File section, Click the button to the right  to browse
for the file to update. Select the time channel from the list below. You



may also select a channel for date if data in the file was collected on
different days. Repeat for the Base Station File section. The Save
Merged Data in File field in the bottom of the Input/Output Files
section contains the location of the result file

Select the number of seconds for the Base Channel Merging
Resolution. Times that have a difference less than this value will be
considered the same.

Click the Set Channels button. The Select Colums to Update
window appears, with the first column containing the data channels
from the base station file. There are two ways of merging. The first
merges data into a new column of the survey file and the second
method updates an existing column.

To merge data into a new column:

Click in the checkbox next to the column to merge and leave
New Column selected in the dropdown list that becomes active
in the Columns: File 3 column.

Click Set

To update an existing column:



Click in the checkbox next to the column to import and select the
channel to update from the dropdown list in the Columns: File 1
column.

In the dropdown list that appears in the Update Mode column
upon your selection, choose between three update modes:
Replace (overwrites an existing column), Average (overwrites
an existing column with the average calculated from the
respective values in File 1 and File 2), and Replace No Data
(overwrites only dummy values).

Click Set.

In the Search for Update section of the Merge Files window:

Select between two methods of searching for the update: In All
Lines (this option searches data in all available lines and sorts
them in order) and In Respective Line (this option searches
and sorts data within each separate line). If you select the
second option, you can also specify the pairs of lines from the
survey and base station files.

To do this:



Click the Set Pairs of Lines button. In the Lines Link Table
window that appears:

Select the line to update in the first (File 1) column. The second
column (File 2) now contains a dropdown list with all the lines
available in File 2.

Select the desired line and click OK.

Back in the Search for Update section of the Merge Files window:

Check the box next to Interpolate if Value is not Found if the
column to import lacks a base channel vaue requested by the
file to update.

Click Merge in the bottom of the Merge Files window to
complete the merge.



BASE Station Corrections
This tool can be used to apply corrections for the temporal variations
in magnetic data when base station data is available. 
The tool may work with a single day or multiple days of surveying.

The tool is designed for use with a single base station data file. For
temporal magnetic variations with 2 base stations please refer to the
manual
        QCTOOL_MAG_BASE_Processing.pdf    found in your
installation

Select BASE Station Corrections from the Processing/Magnetic
Data Processing menu. The following window appears:

The tool assumes that the base station data has been merged with
the survey data according to DATE and TIME
Normally UTC Time would be used but any time information can be
used as long as the survey data and the base station data are linked
by the same time coordinate.



Normally each sheet in the .qct file includes a single profile or flight
line obtained on a single day. Although this is not critical only one
DATE is allowed per sheet for this tool
If your data is organized such that there are multiple dates on any
one sheet, the data must be reorganized.
Thus, if your data covers multiple days but is input as a single sheet,
sort the sheet by date and then break into sheets according to DATE

Input Channels
Select the channels for the Date, Time, Survey Data, and Base
Station Data. The values in the Time channel should be in a
standard time format such as HH:MM:SS.SSS
If the base station data contains high frequency variations not in the
survey data due to the distance of the base station from the survey
data, first filter the base station data.
We suggestion the Gaussian filter for this process. Then use the
resulting filtered data in the input "Base Station Data"

Output Channels
Results can be saved in new channels by selecting Create and
entering the desired channel names. Results may instead be saved
in existing channels by selecting Overwrite and specifying which
channels should be replaced.

Daily Base Station Variation
A search is performed to locate the record with the earliest time for
each day. Note: only the first date value on a sheet is used so there
cannot be multiple days on a single sheet. The base station value at
the earliest time is subtracted from all the base station values for that
day and saved to the Daily Base Station Variation channel.

Average Daily Base Station Variation
The average of all the Daily Base Station Variation values is
calculated for each day and saved to the Average Daily Base
Station Variation channel.

Base Station Correction



The Daily Base Station Variation values are subtracted from the
corresponding Survey Data values and saved to the Base Station
Correction channel.

This process thus computes the variation from the beginning of the
data and subtracts this variation from the data. If you wish to reduce
the data relative to the mean of the base station data for each day,
simply add AvgDailyBaseVar to DailyBaseVar and then subtract
the resulting data from the survey data.



Gravity Data Corrections
Drift Correction
When you calculate Drift Correction, you want to eliminate the instrument error. Also you
want to correct data for the tide effect. This may involve three steps. First, applying Meter
Calibration correction, then, calculating and applying the tide correction, and finally, applying
the Instrument Drift Correction.

Meter Calibration Correction

Tide Correction

Instrument Drift Correction



Meter Calibration Correction

For many older meters the manufacturers provided a single number for meter calibration.
The number was the simple scale factor that converted the meter reading into milliGals by
multiplying the reading times the factor. The scale factor was sometimes engraved into the
meter nameplate. To apply this correction simply use QCTool calculator and apply
instrument scale factor to the readings, which already corrected for tide effect.

Modern meters use a more complete description of the relationship between meter reading
(counter units) and milliGals. Over the extended range of these meters the conversion from
counter reading to milliGals is not perfectly linear; hence, a table rather than a constant is
used. The table for the translation of instrument reading to milliGals is supplied by the
manufacturer.

Import this table to the QCTool to have a qct-file like this:

To apply Meter Calibration table use the Merge Files utility in Tools and then Update
File Channels.

Select your gravity survey file as File 1. For the Base Station channel select the
Readings channel.

Select Instrument Calibration file as File 2. For the Base Station channel select the
Readings channel.

In the Select Columns to Update window, select channel with translation channel.
Leave New Column mode.

IMPORTANT. Check the Interpolate if Value is not found check box. The calibrated
reading data will be calculated automatically.



Tide Correction

Open your gravity survey file and correct data for the tide effect.

Select Latitude, Free Air, Tide, Bouguer and Atmospheric Effect from the
Processing/Gravity Data Processing/Corrections menu. The following window
appears:

Specify Latitude, Longitude, Elevation channels in the respective drop down
menus. Select Tidal algorithm in the correction algorithm list box. Specify
Date and Time channels and GMT difference. Set the name of output
channel. The default value of G is shown but you may change. Click on Apply
button.

The new channel with Tide correction will be created in your work file.

Apply this correction to the channel with instrument readings by using the
calculator. (Insert channel, apply formula new channel = instrument reading -
tide correction (e.g. M = B-L) for all lines, all rows).



Instrument Drift Correction

Characterizing the Drift

Meter drift is often assumed to be a linear phenomenon. If it were truly linear, the drift rate
could be determined from only two readings. You could take a base station reading at the
beginning of the survey and another at the same station at the end of the survey. This is
called a loop tie. From this, you could solve for the constant drift rate and use this to compute
the drift to remove from any observation as a function of time.

Rather than making a single loop tie, you could make several loop ties as the survey
progresses. Within each loop tie, you might assume a linear drift but because you have
many different drift segments, you can reasonably approximate a more complex drift. Once
the drift curve is established, you can compute the drift to remove from any observation as a
function of time.

The file needs to be sorted by time for each day before you begin.

Select Processing/Drift Correction from the menu. The Instrument Drift Correction
window appears:

Ensure that you have selected the Station ID Channel (channel with a station label) as well
as the Data Channel. Set the Reference Channels (Time and Date).

Line Channel - this optional channel is only needed if the same station label is used at
different locations



Select Process days separately if a sheet has multiple days and the drift correction should
be calculated using the first reading on each day. Each sheet will be processed separately
regardless of whether this checkbox is selected or not.

Specify the Output Channel(s). Select Correction Across Days to apply a least squares
approximation so that the difference between base station data values for each day is
reduced.

If Correction Across Days was not selected, apply the drift correction to the data channel
by using the calculator adding function.



Absolute Gravity Calculation
The absolute gravity can be calculated for all stations in the survey file assuming some
stations have been measured at absolute gravity stations.

Select Absolute Gravity Calculation from the Processing/Gravity Data
Processing/Corrections menu. The Absolute Gravity Calculation interface appears.

Select channels from the respective drop down menus.

Reference Station Channel - channel with station label
Reference Station - reference station for which absolute gravity data is known
Gravity Reading Channel - your channel resulting from applying Drift Correction.

Set the Absolute Gravity for the specified reference station.

Specify the Output Channel.

Click the Process button to calculate the absolute gravity.

Note: If you have more than one raw file with gravimeter readings, import all of them into
QCTool first. Then merge all files into one with the Append Files utility.



Terrain Correction

Regional and Local Topography Grid

This application has been designed to create a regional topography grid from data
obtained from various sources.

For example, a regional topography grid can be created from DEM files in BIL,
GTOPO30 or CDED format. The resulting grid can be used in the QCTool terrain
correction algorithm.

GTOPO30 files can be downloaded from the USGS website, CDED from
Resources Canada, and INEGI provides topographic data in .bil format.

NASA satellite DEM data at high resolution is now available almost everywhere in
the world. One source is EarthExplorer.usgs.gov. The .bil format is most
convenient for importing to QCTool to prepare the grids.

These sources also provide high resolution data and thus can be used for the
more accurate local corrections.

Select Processing/Gravity Data Processing/Corrections from the main menu.
Then, select Create Grid from DEM data. The wizard to create such a grid will
appear.

Local Corrections can be made either through use of gridded local terrain data
(*.egr) or Local Terrain Correction (stations)

Step 1

Step 2 (GTOPO30 or BIL)

Step 2 (CDED)

Step 3



Regional Topography Grid Wizard- Step 1

On the first page of the wizard, specify the geographical region by setting the
minimum and maximum values for the latitude and longitude.

If you want to cover the region of your survey data simply check the Obtain Region
from current QCT file check box, specify channels for latitude and longitude and
click on the Obtain Survey Area button. The minimum and maximum values for
latitude and longitude will be updated.

The outer radius can be edited. Click Update to display the new
latitude and longitude limits if you change the outer radius value

Either the GTOPO30, CDED or BIL format can be used for the DEM files. Select.



For GTOPO30, lat/lon must be in WGS84 and for CDED in NAD83. For .bil this will
depend upon the source of the data but be sure to verify that the survey lat/log is
consistent with the DEM lat/lon. If the survey datum is not consistent with the DEM
datum, then the datum and coordinates can be translated as required via
Tools/Coordinates. 

Longitude Block of CDED indicates the number of CDED files required to cover the
selected longitude span. A maximum of two files are allowed.

Latitude Block of CDED indicates the files needed to cover the selected latitude
span. A maximum of two files are allowed.



Regional Topography Grid Wizard - Step 2 (GTOPO30)

On the second page of the wizard, specify the appropriate digital topography file. The
digital topography region provided by the USGS is specified.

For BIL files, change the file type to BIL Files on the Open File window you see after

clicking the  button.

For GTOPO30, the directory of the DEM file should have a header file containing size
and coordinate information for the DEM. This file is expected to have the same name
as the DEM file with a .hdr extension.

Click on the Load Data button to load the elevation data. Check that the Loaded Data
Lat/Lon extremes are consistent with the Selected Region extremes



You can reset the Loaded Data section with the Discharge button.

Click on Next.



Regional Topography Grid Wizard - Step 2 (CDED)

On the second page of the wizard, specify the appropriate digital
topography file(s).
The Selected Region section displays the latitude and
longitude boundaries for the selected region.
The required files needed to cover the selected region will be
determined and labels are displayed to indicate the files that
need to be loaded. e.g. if two files are needed to cover the
selected region, North and South labels are displayed to show
which file contains the data for the northern region and which file
contains the data for the southern region.



Regional Topography Grid Wizard - Step 3

On the third page you will create a grid with topography data file in the QCTool grid
format. Two steps will be processed to get such a grid.

First, the latitude/longitude coordinates are transformed to UTM X and Y. Select
desired Ellipsoid Datum to do this and the Zone should be consistent with the survey
data zone.

Select the Polar Projection checkbox if the survey area is inside the polar bound.
Note: The Add UTM coordinates checkbox must be selected to use the grid with the
Regional Terrain Correction tool.

Second, the regional grid is created. Click the Save Imported Data button and specify
the name of output file. *.qdem. This file is used to perform the regional corrections.

Click the Finish button to produce the grid file.



Regional Terrain Correction

Select Processing/Gravity Data Processing/Corrections from the main menu.

Then select either Continuous Surface Topography or Discontinuous
Prismatic Topography under the Terrain Correction from Grid heading.

The Terrain Correction window appears for a continuous surface:  A DEM grid
must first be prepared.
Note: If in addition to a large regional grid covering the survey area, you have a
smaller higher resolution grid over the survey then this process is applied twice.

·         Specify the DEM Grid file. Valid file formats are EGR or QDEM files, both
of which are QCTool file formats. .qdem maintains the exact sampling of the
original DEM data while .egr uses your interpolation density when the data
is gridded.

EGR files are created after gridding the topographic data and then saving
the grid using the grid mesh tab. QDEM files are native QCTool files built
with the Regional Topography Grid Wizard. You may create a qdem file



without using the wizard by creating a qct file insuring there are channels
named UTM_X, UTM_Y and ELEVATION. Then simply change the file
extension from .qct to .qdem

·         Select file columns for UTM X and UTM Y in the respective drop down
menus and the elevation channel.

·         Specify the Output Channel.

Two elevations are allowed. The elevation provided by the survey or
the elevation provided by the interpolated DEM grid at each station. If
you wish to compare your survey elevation with the elevation provided
by interpolating the DEM grid this information is output as
DEMElevation. For us, comparison of your survey elevations and the
interpolated DEM elevation is critical to good topographic corrections.
Specify the Output Channel

·         Set Parameters: density, inner and outer radii. Suggested value for inner
radius is the resolution of the grid. e.g. Enter 1000 for grid with cells
measuring 1x1 km. Outer radius should be less than the distance between
the outer edge of the DEM and the outer edge of the survey area. For a
SRTM gird, for example, the inner radius would be 30m.

Note: default density is 1 (one) which allows you to create easily new
channels with varying density via the QCTool calculator tool.
Two corrections can be made. First, only the Terrain Residual
correction and second the Full Terrain which means the Bouguer slab
minus the Terrain Residual correction

·         Click on the Calculate Correction button to generate a column with local
terrain correction values.

Prism Correction
If you selected Discontinuous Prismatic Topography, a Prism
Correction checkbox will be visible in the bottom left corner of the
interface. If you deselect the checkbox, the correction will be calculated
using continuous surface topography. (see manual)

Building a Grid from User Elevation Data

If you have your own elevation data, you may use it to build a grid and use this grid
to perform the correction.



·  Import your data into QCTool. You must have UTM X and Y channels in addition
to elevation data.

·  Grid the elevation channel in QCGrid . When you click QCGrid, a Set
Channels dialog appears. Ensure that the correct channels are selected for X,Y,
and data.

·  Interpolate the data using . You can set an appropriate cell size. Note that
the rotation angle must be zero to use the grid for a terrain correction.

·  Click the grid mesh button , then click to save the grid to an EGR file. 

If this elevation data is in a addition to a larger elevation grid then this is
applied before the larger elevation grid. In this case, for the local, high
resolution grid, the inner radius would be the size of the interpolation cells. 
Then for the larger grid, the inner radius is the outer radius of the local grid.



Local Terrain Correction (Stations)

Select Local Terrain Correction from the Processing/Gravity Data
Processing/Corrections menu. Then select Local Terrain Correction from the
submenu.

The Local Terrain Correction window appears:

·         A correction point file in .qct format must first be created. If your
correction data are in Excel, simply export to .csv and open into
QCTool and save. 

·         Select data file columns for Station ID, UTM X, UTM Y, and Elevation in
the respective drop down menus.

·         Specify the qct file with correction points. This file should be already
created with Station ID, UTM X, UTM Y, and Elevation channels. There
should be at least 3 correctional station points for each station of the original



file. You may instead use a file with azimuth, inclination and distance.
Azimuth is measured in degrees east of north. Inclination is measured in
degrees upward from the horizontal. The file should look similar to the
image below:

·         Select columns for Station ID, UTM X, UTM Y, and Elevation in the
respective drop down menus for the file with correction points and select the
checkbox to the left of the drop menus. If your correction file has azimuth,
inclination and distance channels, you may use these channels instead of
UTM X, UTM Y and Elevation by deselecting the checkbox to the left of X, Y
and Elevation and selecting the checkbox to the left of Azimuth, Inclination
and Distance. If both sets of channels are selected with the checkbox, the
values in the channels will be checked to confirm they contain the same
information.

·         Specify the output channel and density.

Click the Calculate Correction button.
The Local Terrain Correction is calculated to be a correction to the Bouguer
corrections which overcompensate for topography. Thus, Local Terrain and
Regional Terrain are to be added back into the final data.



Hammer Correction File

Select Local Terrain Correction (Stations) from the Processing/Gravity Data
Processing/Corrections menu.

Then select Create Hammer Correction File. The Hammer Correction File
window appears:

·         Select columns for Station ID, X, Y, and Z in the respective drop down
menus.

You may change the path of the output file by clicking the Browse
button
Click the OK button.
The columns you selected will be copied to the output file and new columns
for Azimuth, Inclination and Distance are created. A separate sheet of five
rows is assigned to each station.



At least 3 correction stations must be defined for each gravity Station
ID. The azimuth, inclination and distance from the gravity station to
the correction station should be inserted.
Populate these new columns (azim,incl,dist) on each sheet with the desired

values then click the calculator button on the toolbar
The following steps will convert the Azimuth, Inclination and Distance
columns to coordinates in the X_Cor, Y_Cor and Z_Cor columns
Under Result, select the column for X_Cor which is H by default. Select All
Rows and All Lines. Make sure degrees is selected for the angle units. and
select Load Channel formula to load the correct formula
Click Apply
Repeat the above two steps for the Y_Cor and Z_Cor columns which are I
and J respectively.
These steps will produce the coordinates of the correction stations
Save the file and it can be used for Local Terrain Correction



Isostatic Correction

Regional Grid

This application has been designed to create a regional grid from the f4 ice surface version
of the NOAA ETOPO1 global relief model. The grid file etopo1_ice_g_f4.flt can be extracted
from a zip file available at
https://www.ngdc.noaa.gov/mgg/global/relief/ETOPO1/data/ice_surface/grid_registered/bina
ry/

The "Regional topography grid wizard" extracts from the ETOPO1 global map a portion
covering the area of current the .qct file with a 166.7 km overlap on each side, and saves it
as a smaller grid. The extracted local elevation map is saved with a .isgr extension.

In the wizard, the user is directed to set a path to the ETOPO1 grid, or to download it from
NOAA site if it can't be found on the computer. It is too large and not included in the setup
package.

Select Processing/Gravity Data Processing/Corrections from the menu then Create
Grid for Isostatic Correction. The wizard to create such a grid will appear.

Step 1

Step 2

Step 3



Regional Grid Wizard - Step 1

On the first page of wizard specify the geographical region by setting the minimum
and maximum values for the latitude and longitude.

If you want to cover the region of your survey data simply check the Obtain Region
from current QCT file check box, specify channels for latitude and longitude and
click on Obtain Survey Area button. The minimum and maximum values for latitude
and longitude will be updated.

The outer radius can be edited. Click Update to display the new latitude and longitude
limits if you change the outer radius value

The algorithm uses the grid-registered binary ice surface version of the NOAA
ETOPO1 Global Relief Model.

You may click the Download button to send your browser to the URL
http://www.ngdc.noaa.gov/mgg/global/relief/ETOPO1/data/ice_surface/grid_registered
/binary/ and download the required file etopo1_ice_g_f4.zip The zip file contents can
be extracted to any location and this location will need to be entered on the next
page.



Regional Grid Wizard - Step 2

On the second page of the wizard, specify the location of the digital topography file by

clicking the  button.

Select Use water mask maps if you need to differentiate between negative
elevations on land and negative elevations in water. Otherwise, select No negative
inland elevations

Click on the Load Data button to load the elevation data.

You can reset the Loaded Data section with the Discharge button.

Click on Next.

The DEM File Info section is not used for isostatic correction.



Regional Topography Grid Wizard - Step 3

On the third page you will create a grid with topography data file in the QCTool grid
format. Two steps will be processed to get such a grid.

First, the latitude/longitude coordinates are transformed to UTM X and Y. Select
desired Ellipsoid Datum to do this. Select the Polar Projection checkbox if the survey
area is inside the polar bound.
Note: The Add UTM coordinates checkbox must be selected to use the grid with the
Isostatic Correction tool.

Second, the regional grid is created. Click the Save Imported Data button and specify
the name of output file.

Click the Finish button to produce the grid file.

You may use the produced grid file to perform isostatic correction by selecting
Isostatic correction from the Processing/Gravity Data Processing/Corrections
menu.



Isostatic Correction

Select Isostatic Correction from the Processing/Gravity Data Processing/Corrections
menu. The Isostatic Correction window appears:

Specify the Isostatic correction grid file. The file needs to be an ISGR file built with the
Isostatic Regional Grid Wizard.

Select file channels for UTM X and UTM Y in the respective dropdown menus.

Specify the Output Channel.



Choose between either the Airy-Heiskanen model proposed by Airy with equations
developed by Heiskanen, the Pratt-Hayford model which was proposed by Pratt with
equations by Hayford or the what we term the Extended Heiskanen model which was
proposed by Heiskanen as a compromise between the Airy approach and the Pratt
approach.

Set Parameters: densities, inner and outer radii. Suggested value for inner radius is
the resolution of the grid. e.g. Enter 1000 for grid with cells measuring 1km. Outer
radius should be less than the distance between the outer edge of the grid and the
outer edge of the survey area.

The value you choose for compensation depth will be the assumed thickness of the
crust.

Click on the Calculate Correction button to generate a column with local isostatic
correction values. These values need to be subtracted from your instrument readings
to apply the correction



Latitude, Free Air, Atmospheric
It is suggested if your working coordinates are not in a modern datum (e.g. NAD27) that you
create new channels with coordinates in more modern datums such as NAD83 or WGS84
and that the processing be done with regard to these coordinates, so as to be able to utilize
modern ellipsoid models. At completion, you may then utilize your original coordinates.

Select Latitude, Free Air, Tide, Bouguer, Atmospheric Effect from the
Processing/Gravity Data Processing/Corrections menu. The following window appears:

Select Theoretical, Free Air Correction, Direct Free Air or Atmospheric algorithm from
the Correction Algorithm list

Specify Latitude, Longitude, Elevation channels in the respective drop down menus
as required.

Select the desired formula from the list.

Set the additional parameters for each algorithm as requested (e.g. theoretical gravity
correction system for Latitude correction, density value for the Bouguer slab
correction.

Confirm the output channel name for each algorithm or rename.



Click the Apply button. The new channels with theoretical gravity data, atmospheric,
free air correction and simple Bouguer corrections data will be created. The output
channels are the gravitational effects of each effect and NOT corrected data.

Note: The theoretical or Latitude correction not only removes the gravity response for
the theoretical ellipsoid with a uniform density for a station on the geoid but also the
gravity effects due to the rotation of the earth at the station’s latitude.

The newly constructed channels are to be subtracted from the Observed data.

For example, to calculate the reduced gravity value with simple Bouguer correction,
use the formula Corrected_Gravity = Gravity_Observation_Final - Gravity_Theoretical
- Free Air correction - Atmospheric Effect - Bouguer correction .

NEW Direct Free Air result: The final free air by definition is the observed data minus
the theoretical value which is calculated at the surface of the ellipsoid mode minus a
correction for the excess theoretical value between the height of the station and the
geoid.

The gravity value due to the geoid at the station elevation (theoretical at the station) is
less than that at the geoid if the station is above the geoid and greater if above the
geoid. The traditional approach is to calculate the strength at the geoid and then the
differential gravity between the elevation and the geoid and then use the two values to
create the final theoretically reduced data at the station elevation. This is an
unnecessary strep as the final corrected Free Air can be calculated easily directly. In
this case, the output channel is the final Free Air calculation.



Bouguer Slab, Spherical Cap
Select Latitude, Free Air, Tide, Bouguer, Atmospheric Effect from the
Processing/Gravity Data Processing/Corrections menu. The following window
appears:

Select the Bullard A (Bouguer slab) or Bullard B (Spherical cap) algorithm
from the Correction Algorithm list

Specify the Elevation channel in the respective drop down menu as required

Select the desired formula from the list

Set the additional parameters for each algorithm as requested (e.g. density
value for the Bouguer slab correction)

The Gravitational constant may be adjusted if you desire

Confirm the output channel name for the algorithm or rename.

Click the Apply button. The new channels with theoretical gravity data,
atmospheric, free air and simple Bouguer corrections data will be created.
The output channels are the gravitational effects of each effect and NOT
corrected data.



To calculate the reduced gravity value with simple Bouguer correction, use
the formula Corrected_Gravity = Gravity_Observation_Final -
Gravity_Theoretical - Free Air correction - Atmospheric Effect - Bouguer
correction.

Bullard B is the difference between the spherical cap and the slab. Thus, the
total effect of the cap is Bouguer Slab plus Bullard B. Thus, Bullard A and
Bullard B are both removed from the Observed data.

The Bouguer slab and Spherical Cap corrections both overestimate the
effects of the local topography and thus the local topography correction is be
added back into the above formula.



Eötvös Correction
Select Eötvös Correction from the Processing/Gravity Data
Processing/ Corrections menu. The Eötvös gravity correction
window appears.

Three algorithms are available. Glicken, (Glicken, M. 1962) is the
standard Eötvös including the vertical component of the Coriolis as
well as the second centrifugal term. This assumes a constant
elevation above the ellipsoid and low velocities and thus suitable for
marine gravity. Harlan (Harlan, R.B. 1968) is an improvement to
account for higher velocities and incorporates the effects of the
earth’s flattening. It does not account for accelerations due to



variations in the vehicle altitude above the ellipsoid surface.
Accurate, is our modification of Harlan which are improvements in
his approach to his approximations in the terms dependent upon the
ellipticity.

Select channels from the respective dropdown menus. Glicken does
not require an elevation channel.

Speed is the total speed along the surface and heading provides the
vector direction.

Define the Ellipsoid by either selecting a Formula or entering
values for the Equatorial Radius and Inverse Flattening

Specify the Output Channel. You may overwrite an existing channel
or create new one.

Click the Process button to calculate the correction for the Eötvös
effect. The output channel by our convention is to be removed from
the processed gravity channel to be consistent with the other
corrections.



Process Repeats
This tool generates statistics for repeated stations.

Select Process Repeats from the Processing/Gravity Data Processing menu. The
Process Repeats dialog appears.

Select channels from the respective drop down menus.

Data Channel - channel with data values to be averaged
Station ID Channel - channel with station label
Line Channel - this optional channel is only needed if the same station label is used
at different locations

In the Calculate statistics for section, you select the sheet for which statistics will be
calculated by selecting One Sheet and the sheet name in the combo box. You may also
select All sheets. This selection only affects the results on the repeat statistics window that
is displayed when after clicking the OK button. Results saved to the data channels will
always analyze all stations in all sheets.

Average data and Data error results will be output to two channels. If a station has at least
one duplicate, the average data value for all duplicates of that station is saved. A dummy



data value will be saved otherwise. The error is equal to the difference between the average
and the data value measured at the station. Select whether existing channels should be
overwritten or new channels created in which case, the names for the new channels may be
edited.

Repeat statistics
Click the OK button to generate the data and display a page of statistics. You may save
these results to a text file by clicking Save

Total number of stations - Number of unique stations
Number of repeated stations - Number of unique stations that have duplicates
Percentage of repeat stations - Calculated using A/B*100 where A is the number of
repeated stations and B is the total number of stations
Total number of readings - Number of readings including duplicates
Number of repeated readings - Number of readings that have duplicates, readings
with no duplicates are not included
Percentage of repeat readings - Calculated using C/D*100 where C is the number
of repeated readings and D is the total number of readings
Maximum of repeat difference - Largest of the values in the Data error channel
RMS difference - root mean square of all the data error values



MT Processing

Select Processing -> Magnetotelluric Data Processing -> 2D MT Parameters from the menu.
Produces 2D Strike Angle, Skew Angle and the 2 principal impedances (Rho/Phase)

Confirm that the channels selected for the real and imaginary
parts of the impedance tensors are correct.>
Also check that the channels for frequency and impedance units
are correct.
From this interface you can perform any of the operations listed



MT Matrix Rotation

Select Processing -> Magnetotelluric Data Processing -> MT Matrix
Rotation from the menu.

Select your channels for real and imaginary of the 4 impedance
elements plus frequency channel and your impedance units

Select Rotate impedance matrix then Process



The names of the output channels that will be created are
displayed in the top half of the window
Any channels that exist with the displayed output names will be
overwritten unless the checkbox labelled Overwrite output
channel is deselected.
If Fixed angle is selected, enter the rotation angle in the box
below the label. The output channel names are updated to
include the angle as part of the name.
If Angle from channel is selected, select a channel that
contains the rotation angles you would like to use.
In the Rows section, you can specify which records will be
processed.
When all selections are correct, click Process to create the new
channels.



Apparent Rho/Phase conversion

Selecting Magnetotelluric Data Processing|Apparent
Resistivity/Phase Covnersion from the Processing menu
launches the following interface:

Select the impedance tensors you would like to convert in the
Output channels section
The names of the output channels that will be created are
displayed in the Output channel names section.
Any channels that exist with the displayed output names will be
overwritten unless the checkbox labelled Overwrite output
channel is deselected.
The desired units for the phase can be selected in the Phase
units box.
When all selections are correct, click Process to create the new
channels.



Standard 2D parametrization

Select Standard 2D parametrization from the main MT Processing
window and continue to launch the following interface:

Select the 2D Decomposition Features for which you would like to
create channels. There are four different items to choose from.



Spectral to Impedance Conversion

Select Processing -> Magnetotelluric Data Processing -> Spectral to
Impedance Conversion from the menu. You may choose either the
standard or theoretical version of the algorithm.

If the spectral data is in .edi format then using QCTool’s MT Spectral
EDI import produces default channel names. Otherwise, some re-
organizing and naming may be required.

Within the spreadsheet are 7 columns (records), one for
Hx,Hy,Hz,Ex,Ey, and two additional ones Hx, Hy which can be
remote channels
Confirm that the channels selected for the frequency,
component and coordinates are correct. Also check that the
channels for the reference real and imaginary parts of the Hx
and Hy components are correct.
You may select whether you would like impedance, tipper or
both channels created. At least one must be selected. The
function will produce a new file.



You may also select whether reference or local measurements
will be used for the conversion.
The function expects the magnetic reference channels be
named SHXR and SHYR
The data channels are named SHX, SHY, SHZ, SEX, SEY, for
example, SHX_Re and SHX_Im



FDEM Apparent Resistivity - LIN

Based upon the single term LIN approximation for short offset dipole-
dipole FDEM systems – EM31, EM38, GSSI Profiler, etc

Select FDEM Processing from the Processing menu. Then select Apparent Resistivity -
LIN. The following window appears:

This example is for the GSSI Profiler which outputs the
Quadrature data in units of PPM.
Click the checkbox beside the channels for the quadrature data
in the Quadrature Data section.
Units for the quadrature data can be specfied below the channel
list
Double click the relevant frequency cell to enter the value in
Hertz if not automatic.
The orientations of the transmitter and receiver can be selected
in the Tx-Rx Orientation section.



The value for the separation is entered in the Separation section
as well as the array type of the system. You may choose
between Co-axial, vertical coplanar (VCP), horizontal
coplanar(HCP) or perpendicular (PRP). Different options will be
available depending on what has been selected for the Tx-Rx
Orientation.
A channel for separation may be selected instead of entering a
value by clicking the Channel checkbox in the Separation
section and selecting a channel from the drop down list below.
In the Output Channel section, select if apparent resistivity,
apparent conductivity or both need to be calculated. Also, select
the Data Type and number of Decimal Digits for the values in
the output channel.
Click the OK button when all the settings are correct.



Convert Apparent Conductivity to Apparent
Resistivity

Many FDEM instruments output apparent conductivity as data units.
These values are based upon a simple, very approximate formula
which takes the relative data and converts to conductivity. In most
cases, it is more useful to examine the apparent resistivity.

Select FDEM Processing from the Processing menu. Then select Convert Apparent
Conductivity/to ApparentResitivity. The following window appears:

Select the channels to be converted in the Apparent
Conductivity Channels list box.
EM data needs to be in units of mS/m.
New channels will be created containing apparent resistivity
values. The channel names will be constructed using the
apparent conductivity channel name and the text entered in the
Output name suffix box.



Click the OK button to convert the data.



FDEM Apparent Conductivity to Instrument Units

You can convert FDEM data from apparent conductivity to instrument units. Select FDEM
Processing from the Processing menu. Then select Convert Apparent Conductivity/to
Instrument Units. The following window appears:

This example is for EM34 data collected at 10m separation for
which 6400Hz is used.
Select an input column for the Apparent Conductivity Data in
drop down box in the upper left corner of the window.
Enter the frequency in Hertz.
The orientations of the transmitter and receiver can be selected
in the Tx-Rx Orientation section.
The value for the separation is entered in the Separation
section as well as the array type of the system. You may choose
between Co-axial, vertical coplanar (VCP), horizontal
coplanar(HCP) or perpendicular (PRP). Different options will be



available depending on what has been selected for the Tx-Rx
Orientation.
In the Output Channel section, enter a Name for the new
channel that will be created for the output data. Also, select the
Data Units, Data Type and the number of Decimal Digits for
the values in the output channel.
Many instruments use either Percent or PPm as raw data units.
Click the OK button when all the settings are correct.



Set Time Channels
Select Set Time Channels from the Processing/TDEM Processing
menu. The Set Time Channels interface appears.

Channels with associated time windows are selected by default.
Select the channels to which you would like to assign time
windows.
The time window values can be entered using either Load
Window Times or View and Edit Window Times.
Deselect any channels from which you would like to remove its
associated time window.



View and Edit Time Windows
Select View and Edit Window Times from the Processing/TDEM
Processing menu. The View and Edit Window Times interface
appears.

Existing start and end times are displayed for all channels specified
as time window channels. Time window channels are defined using
Set Time Channels.

Any start time or end time can be edited by double clicking on
the desired cell.
Mid times will be displayed for files defined in that format.



Load Window Times
Select Load Window Times from the Processing/TDEM
Processing menu. The Load Time Windows interface appears.

Existing start and end times are displayed for channels specified as
time window channels.

Click the Load Windows button to replace the time values with
value saved in a qct file.
The interface to select the qct file appears



Click browse to select the qct file containing the time window
values. The file needs to have channels for start time and end
time.
The channels can be selected in boxes beside the Start Time
and End Time labels
Specify the units of the time values in the file in the Units
section
Click OK when all the settings are correct
The values from the file are now applied to the time window
channels
The number of time windows in the file does need to be the
same as the number of time window channels. For example, if
the file only contains ten time windows, the time window values
will only be assigned to the first ten time window channels.



Induced Polarization Cole-Cole Parameters

Select IP/Resistivity Parameters from the Processing menu. Then select IP Cole-Cole.
The following window appears:

Select input columns for real and imaginary parts of the data in
the respective drop down menus. A column for the station label
may also be selected.
The Frequencies list box updates when the frequency column is
changed. Unwanted frequencies can be deleted by clicking the
appropriate value with the mouse while holding the control key.
Six channels of data displayed in the Output Channels section
are calculated with this tool. New channels can be created using
the names entered or if the Overwrite option is clicked, existing
channels can be selected to be overwritten.
A Name Suffix can be entered that will be added to the names
of each of the output channels if using the Create option
Click the OK button when all the settings are correct.



DC Apparent Resistivity

Select IP/Resistivity Parameters from the Processing menu. Then select DC App Rho.
The following window appears:

Note: for remote POLE electrodes, "*" will be recognized as infinite.

Select input columns for transmitter and receiver electrode
coordinates in the respective drop down menus. Any detected
columns will be selected automatically. Indicate if any
coordinates are or are not available by using the checkboxes
labelled Select X coordinates, Select Y coordinates, or
Select Z coordinates
Select the channel for the voltage which must be in milliVolts.
Select the channel for the current which must be in units of
Amps or milliAmps. If a current channel is not available,



deselect the Current checkbox and a current of 1 Amp will be
used for the calculation.
Select Create to place the output data in a new channel with the
entered name.
Select Overwrite to overwrite an existing column that can be
selected in the drop down list.
Click the OK button when all the settings are correct.



Merging Files

QCTool allows two ways of merging files: updating one file with the data from
another and merging two files using the same base channel (usually, the Fiducial
channel). In both cases:

Close any opened files.

Select Tools/Files/Merging Files on the QCTool menu. The Merging Mode
dialog opens, with the Update File Channels option selected by default:

Leave the Update File Channels option selected if you want to update your
file with channels from the 2nd file or select Union of Files to merge the two
files, and click Continue.

See also:

Union of Files

Updating Files



Updating Files

In some cases, you may need import separate columns from one file to another.
This option is especially useful when you have two different files containing data of
one survey; for example, one of the files contains the coordinates of your
measuring stations and the other - the measured data.

Select Tools/Files/Merging Files on the QCTool menu. In the Merging
Mode dialog that appears:

Leave the Update File Channels option selected and click Continue.

The Merge Files dialog opens:



In the File 1 section of this dialog:

Click the Open button to browse for the file to update.
Select the base channel from the respective list below.

In the File 2 section of this dialog:

Click the Open button to browse for the file, from which you want to import
an update.



Select the base channel from the respective dropdown list below.

The Save Merged Data in File field in the bottom of the Input/Output Files
section contains the location of the result file.

In the box below the Input/Output Files section:

Select the number of digits after the decimal point. This is a precision order
QCTool uses to merge base channel data from different files.

In the Merging Mode section:

Click the Set Channels button. The Select Colums to Update dialog
appears, with the first column containing the data from the file to import.
There are two ways of import. The first imports data into a new column of the
file to be updated and the second updates an existing column.

To import data into a new column:

Click in the checkbox next to the column to import and leave New Column
selected in the dropdown list that becomes active in the Columns: File 1
column.

Click Set



To update an existing column:

·         Click in the checkbox next to the column to import and select the channel
to update from the dropdown list in the Columns: File 1 column.

·         In the dropdown list that appears in the Update Mode column upon your
selection, choose between three update modes: Replace (overwrites an
existing column), Average (overwrites an existing column with the average
calculated from the respective values in File 1 and File 2), and Replace No
Data (overwrites only dummy values).

·         Click Set.

Back in the Search for Update section of the Merge Files dialog:

Select between two methods of searching for the update: In All Lines (this
option searches data in all available lines and sorts them in order) and In
Respective Line (this option searches and sorts data within each separate
line). If you select the second option, you can also specify the pairs of lines
from File 1 and File 2.

To do this:

Click the Set Pairs of Lines button. In the Lines Link Table dialog that
appears:



Select the line to update in the first (File 1) column. The second column (File
2) now contains a dropdown list with all the lines available in File 2.

Select a required line and click OK.

Back in the Search for Update section of the Merge Files dialog:

Check the box next to Interpolate if Value is not Found if the column to
import lacks a base channel vaue requested by the file to update.

Click Merge in the bottom of the Merge Files dialog.

The Next Step dialog appears:



In this dialog:

Select Start Another Merging Process if you want to import new updates
into the same file or update another file. This brings the Merge Files dialog
back. Repeat the steps described above.

Select Open the Result File in Read-Only Mode if you do not want to
change the updated file.

Select Open the Result File in Read/Write Mode if you want to change the
updated file.

Select Exit to quit the Merge Files application.

Click Continue to close the dialog.



Union of Files

In case your file contains a base channel, which is a column with values sorted in a strictly
ascending order (e.g. Fiducial Channel), you can merge it with one or more other similar
files. For this purpose, you do not need to open these files.

Select Tools/Files/Merge Files. In the Merging Mode dialog that appears:

Select Union of Files. The Merge Files dialog opens:



In the File 1 section of this dialog:

Click the Open button   to display the standard Open dialog.

Select the file you want to merge and click Open. Its name and path appear in the
File 1 field.

Select the base channel from the dropdown list below, containing all channels from
your file.

In the File 2 section:



Click the Open button  to bring up the standard Open dialog.

Select the second file to merge with the one in the File 1 section and click Open. Its
name and path appear in the File 2 field.

Select the base channel from the respective dropdown list below.

In the Save Merged Data in File field:

Click the Open button to bring up the standard Save As dialog, select the folder to
save the new (merged) file into, and enter its name in the File Name field.

Click Save to return to the Merge Files dialog. The name of the new file and its
location appear in the Save Merged Data field.

In the Base Channel Merging Precision field:

Specify the number of digits after the decimal point for the base channel in the box on
the right. This is a precision order QCTool uses to merge base channel data from
different files.

In the Merging Mode section:

The Interpolate Channels box is checked by default. De-select it to cancel
interpolation. The cells, which otherwise would have been filled with the results of
linear interpolation, will contain asterisks.

To merge all data into one table without dividing it into lines, leave the Keep Data in
One Line box checked (it is checked by default).

To divide a table into lines, de-select the Keep Data in One Line box and specify the
number of points per line in the Split Data into Lines at Points field.

Click Merge in the bottom of the Merge Files dialog. In case any of your files has no base
channel, a message will warn you that the merging has failed. If the merging is successful,
the Next Step dialog appears:



In this dialog:

Select Start Another Merging Process if you want to merge one more file with the
two already merged or to merge another pair of files. This brings the Merge Files
dialog back. Repeat the steps described above as many times as needed.

Select Open the Result File in Read-Only Mode if you do not want to change the
merged file.

Select Open the Result File in Read/Write Mode if you want to change the merged
file.

Select Exit to quit the Merge Files application.

Click Continue to close the dialog.



Appending files

In some cases, you need to append, or attach, one file to another.

Select Tools/Files/Append Files on the QCTool menu. In the window that appears:

Click the Open button  in the File 1 section to browse for the first file.

Click the Open button  in the File 2 section to browse for the file to append.

Compare the File 1 and File 2 columns in the respective table below.

If a File 2 column does not coincide with a File 1 column, you can always change the
former to match the latter. Click on it and select a required column from the dropdown
list to appear.

Click the Open button  in the Save Results in File section to specify the file to
save your newly created data set in.



Click Append. Your new file appears in the current window.



Digital Filter

Click the Processing -> Filters -> Digital Filter. The dialog appears.

Select a data channel for filtering
Select a data range if needed in the Select all rows section. As well as
Apply for all Lines
Select output mode. If create mode is chosen, a new channel will be inserted
after base channel
Select filter type: Mean filter, Median filer, Gaussian filter, Decimation filter,
Fraser filter,  or Gaussian High Pass
Decimation filter also is available as a separate menu item in Processing ->
Filters submenu list.
Set Filter to define the parameters for the filter
Give the output channel a name
Click the Run button to filter data



Fast FT Filter

Click the Processing -> Filters -> FFT Filter. The dialog appears.

Select FFT or DFT. Window width for FFT must be 2N

Select a data channel for filtering

Select a data range if needed

Select output mode. If create mode is chosen, a new channel will be inserted after base
channel

Select filter: Low pass filter, high pass filter, Band pass, Band remove and notch filter

The data will be divided into segments of Window width length and sent through the FFT a
segment at a time. Replace data specifies the number of values in each segment that are
overwritten by neighbouring segments in order to avoid discontinuities. The Window width
and Replace data values need to be powers of two. 

The Sample Channel needs to have data with a regular interval in units of seconds. The
Sample Rate is the inverse of the Sample Interval 

Click the Run button to filter data 



Click the Transform only button to transform data without filtering 

Check the Display transform. The window changes to

Click Save transform Info to save the transform information to a QCT file

The filtered data is plotted in blue. The unfiltered data is plotted in red.

Click the  button to zoom in on a section of the plot. Choose the area you want to see
by selecting rectangle on the plot with the mouse

Click the  button to toggle the display of a mesh on the plot
The appearance of the plot can be controlled by clicking the Axes Settings button



FFT Spectral Analysis

Click the Processing -> Filters -> FFT Spectral Analysis menu item. 

Select FFT or DFT for Analysis

FT requires window width to be 2N but this is not required for DFT

Select a data channel for spectral analysis



Select number of rows if required

The value for Window width will be the number of frequencies used in the spectral
plot. 

The Sample Channel needs to have data with a regular interval in units of seconds.
The Sample Rate is the inverse of the Sample Interval 

Click the Run button to filter data 

Click the Transform only button to display a spectral plot 

Select one of the tapering functions if desired. The data will be
multiplied by this function before applying the FFT/DFT.
Check the Display transform button to toggle the spectral plot.
Click Save transform Info to save the transform information to a specified QCT file
The file has channels for real, imaginary, amplitude and phase. If a tapering function
has been selected, results with and without the use of the tapering function will be
saved in the same file.

Click the  button to zoom in on a section of the plot. Choose
the area you want to see by selecting rectangle on the plot with
the mouse

Click the  button to toggle the display of a mesh on the plot
The appearance of the plot can be controlled by clicking the
Axes Settings button
Click the Normalization selection button to normalize the data
by the number of data values. You may also select between
display of real, imaginary, amplitude and phase.



Stack Utilities
Jackknife
The purpose of the jackknife function is to facilitate processing of
repeat stations in a dataset. To use this function, select up to 10
rows, right-click and select Jackknife. The following window
appears:

Make a selection in the Channel section and you will be able to
view the average and standard deviation for these rows. Decimal
number specifies the number of decimal places for the displayed
values.

Deselect entries in the Selected Rows section as desired to
observe the effect on the statistics. When you click Apply the
average value of the selected rows will be saved for each channel in
a new row.



The standard deviation will also be saved. Select Create
Channel and enter a new channel name to save the standard
deviation in a new channel. Select Overwrite to replace an existing
channel that you may also select.



Stack Data
Use this tool to average groups of data. Select Processing/Stack
Utilities/Stack Data to open the following window:

Enter the number of groups of data values to be averaged in the
box labelled Number of Stacks. and set the Number of Samples in
Stack.

Initial data values can be skipped by entering a value for the
Starting Stack Index. E.g. entering 10 will not include the first nine
values in the stack result.

Select a channel for the Sample Index Channel. Values in this
channel need to be increasing at a regular interval.

Select the channel you would like to process in the Channel to be
stacked list.

Processing may be performed on a single sheet by selecting
Stack Cycles for Sheet. Stacking will only be done for the selected
sheet.



The Stack Records option will be enabled if there is more than
one sheet. The number of samples will be set to the maximum
number of values in a sheet when this option is selected.

Start the processing by clicking the Stack button
New channels will be created for Stacked Data and Standard

Deviation using the specified channel names. Select Overwrite if
you would prefer to replace existing channels.

Data results can be saved to the first cycle only, all cycles used
or all cycles.



Bin Data
To perform data binning on a channel, select Processing/Stack
Utilities/Bin Data to open the following window:

This application bins consecutive records by averaging each channel
through each bin for all channels and producing new averaged
records and compressing the data simultaneously.

For this tool to work correctly, the channel you select in the
Reference Channel drop down menu needs to be sorted to be
monotonic increasing or decreasing (use SORT function).

You can process All lines/spreadsheets or the Current line
only.

A number of data bins are created. The first bin will contain the
values in the channel that fall beteween two values. Those values in
the units of each channel are the Start value and the Start Value
plus the Bin width. The second bin starts where the first bin ends
and uses the same bin width. The range of the next bin to the end of
each channel are calculated in the same fashion.



The bin width is equal to the sampling rate of the reference
channel times the number of records.

Select End of each interval to create a channel containing the
end values of the bins

Select Number of points averaged to create a channel
containing the number of records averaged in each bin.

Click OK and the first row in each bin will contain an average of
all the rows in the bin. The other rows are deleted.



Bin TEM Data
To perform binning of digitally sampled full waveform data into
windows, select Processing/Stack Utilities/Bin TD Data to open
the following window:

If the Process All Lines Separately checkbox is not checked, all
lines will be merged into one line.

Select a Fiducial Channel and a Display Channel to display a
small plot of the Display Channel

Start point specifies the row that contains the first time value you
want to use in the Fiducial Channel.

Enter a Base frequency and the Base time period will be
updated. The value for the Base time period must be less than the
largest value in the Fiducial channel.

Select a display channel and it will be plotted in red and the
processed data is plotted in blue.

Click on the channels on which you would like to perform
processing in the Select Channel(s) to bin box



Load your windows definition files
The Base time period will be divided by the Number of binned

time windows. All the values that fall within a certain data bin will be
averaged.

Click Bin to begin processing
Click Save Results to save the processed data to a qctool file.

For a base time period, each averaged value will be given its own
channel.



Average Duplicates
To average rows that are duplicates, select Processing/Stack
Utilities/Average Duplicates to open the following window:

The channel indicated in the Channel drop down menu will be
analyzed for duplicate values. Starting from the first value, each
subsequent value that is within the range indicated by the Delta
value will be added to the group to be averaged until a value is
detected that falls out of the Delta range. Then a new group of
values to averaged is created.

You can specify whether you want averaging to be performed on
All lines, only the Current line or for a specific range of rows on the
current line. Specify the range in the boxes labelled Rows from: and
to:

In order for this tool to work correctly, the selected channel needs
to be sorted. Click OK to start processing. The first row in each
averaging group will contain the results. The other rows retain their
original values. However, in the selected channel, the entries not
averaged are set to a dummy value.



QCTool Reference
File menu commands

The File menu offers the following commands:

New QCT File Creates a new qct-file.
   

Open QCT File Opens an existing qct-file.

   
 Close Closes an opened qct-file.
   

Save QCT file Saves an opened qct-file using the same file
name.

   

 Save As Saves an opened qct-file to a specified file
name.

   
 Import File Import data from a specified file name.
   

Print
Prints a map from the Grid Mapping Window 

   

 Print Preview Displays the document on the screen as it
would appear printed.

   
 Print Setup Selects a printer and printer connection.
   
 Print Selection Area Selects a portion of channels for printing.
   

File Manager Invokes a dialog to manage the opened qct-
files.

   
 Exit Exits QCTool



Edit menu commands
The Edit menu offers the following commands:

Undo Reverse previous editing operation.

Cut Deletes data from the spreadsheet and moves it to the clipboard.

Copy Copies data from the spreadsheet to the clipboard.

Paste Pastes data from the clipboard into the spreadsheet.

Note: Edit menu functions not implemented in the current version



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.
Spreadsheet
Font Displays the interface to specify the font for the spreadsheet.



Window menu commands
The Window menu offers the following commands, which enable you to arrange multiple
views of multiple documents in the application window:

 New Window Creates a new window that views the same document.

Cascade Arranges windows in an overlapped fashion.

Tile Horizontally Arranges windows Horizontally.

Tile Vertically Arranges windows Vertically.

 Arrange Icons Arranges icons of closed windows.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this
application:

QCTool Help Offers you an index to topics on which you can get help.

 About QCTool Displays the version number and license type for this
application.

 Register a QCTool
license

If using QCTool in evaluation mode, select this option to
enter your serial number. Registration can also be done
by selecting the Register option from the QCTool folder on
the Windows Start menu. You must have administrative
privileges to do this task.

 Deregister a QCTool
license

Should you wish to move a registration from one
computer to another, simply select "Deregister". Then you
may install and register on another computer.

 Check for Updates

Updates are periodically made available for current
licenses. Use this option to see if there are any updates
for which you are eligible. Updates can also be checked
by selecting the Update option from the QCTool folder on
the Windows Start menu. You must have administrative
privileges to do this task.

 Use Proxy to get
Updates

Select this option when having problems connecting to
the update server to check for updates.

 Extend Update Period

When your license maintenance has expired you may
purchase a one year license renewal. After you see a
window displaying your serial number, your browser will
be launched to a site where you will be able to pay for
your renewal.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar. The
toolbar provides quick mouse access to many tools used in QCTool,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

    Create a new qct file. QCTool displays the interface to specify the channel and line
information.

    Open an existing qct-file. QCTool displays the Open dialog box, in which you can
locate and open the desired file.

    Save the active qct-file with its current name.

    Import data from a file. QCTool displays the supported file formats you can choose
from. Then, you can locate the desired file and save the data to a qct format.

    Refresh. Effectively, saves then reopens a file.

    Removes all plots and saved plot settings.

    Invoke a dialog to manage the opened qct-files. You can close, hide or activate
different view windows of the opened file.

    Show/hide the spreadsheet window of active qct-file.

    Show/hide the plotter window of active qct-file. If plotter is being displayed for the first
time, the data from the selected column will be plotted

    Show/hide the grid window of active qct-file.

 Make a selection from a list of existing lines.



    Duplicate the current line.

    Invoke a dialog with line information.

    Cut the current line at a selected point.

    Mark a selected line as deleted.

    Mark selected points (locations) as deleted.

    Insert a new point (location).

    Insert points (locations) .

   Undo last action on the spreadsheet.



License and Ordering
Information
QCTool(R)
Copyright (C) 2006-2022 Eikon Technologies Ltd.
All Rights Reserved



QCTool SOFTWARE LICENSE

EIKON TECHNOLOGIES LIMITED 

You should carefully read the following terms and conditions before
using this software. Unless you have a different license agreement
signed by Eikon Technologies Ltd("PEI"), by using, copying,
transmitting, distributing or installing QCTool, you agree to all of the
terms of this license. 

If you do not agree to any of the terms of this license, then do not
install, distribute, transmit, copy or use QCTool. If you have paid PEI
or an authorized PEI distributor for this copy individually, you may
return it unused, within thirty (30) days after purchase, for a full
refund of your payment minus costs.

When this copy of QCTool has been registered, it may be installed
on a single workstation used by a single person or used non-
simultaneously by multiple people. This is not a concurrent use
license.

The license is granted to the purchaser and is non-transferable to
either another individual, company, organization or department within
an organization.

Until QCTool has been registered, it is a free evaluation software.
Subject to the terms below, you are hereby licensed by PEI to use
this software for evaluation purposes for up to seven (7) days without
charge.

You may, without making any payment to PEI or its agents:
a) give exact copies of the evaluation version of QCTool personally
to anyone;
b) distribute exact copies of the evaluation version of QCTool, if done
exclusively through electronic channels;
and
c) produce as many exact copies of the evaluation version of QCTool



as you wish, for purposes of distribution as described in (a) and (b)
above.

YOU ARE SPECIFICALLY PROHIBITED FROM CHARGING, OR
REQUESTING DONATIONS, FOR ANY COPIES, HOWEVER
MADE, AND FROM DISTRIBUTING SUCH COPIES WITH OTHER
PRODUCTS OF ANY KIND, COMMERCIAL OR OTHERWISE,
WITHOUT PRIOR WRITTEN PERMISSION FROM PEI.

PEI RESERVES THE RIGHT TO REVOKE THE ABOVE
DISTRIBUTION RIGHTS AT ANY TIME, FOR ANY OR NO
REASON.

You may not alter or modify the Software, nor give anyone
permission to do so.

THIS SOFTWARE, AND ALL ACCOMPANYING FILES, DATA AND
MATERIALS, ARE DISTRIBUTED "AS IS" AND WITH NO
WARRANTIES OF ANY KIND, WHETHER EXPRESS OR IMPLIED.
Good data processing procedure dictates that any program be
thoroughly tested with non-critical data before relying on it. The user
must assume the entire risk of using the program. THIS
DISCLAIMER OF WARRANTY CONSTITUTES AN ESSENTIAL
PART OF THE AGREEMENT.

ANY LIABILITY OF PEI WILL BE LIMITED EXCLUSIVELY TO
REFUND OF PURCHASE PRICE. IN ADDITION, IN NO EVENT
SHALL PEI, OR ITS PRINCIPALS, SHAREHOLDERS, OFFICERS,
EMPLOYEES, AFFILIATES, CONTRACTORS, SUBSIDIARIES, OR
PARENT ORGANIZATIONS, BE LIABLE FOR ANY INCIDENTAL,
CONSEQUENTIAL, OR PUNITIVE DAMAGES WHATSOEVER
RELATING TO THE USE OF QCTool, OR YOUR RELATIONSHIP
WITH PEI.

IN ADDITION, IN NO EVENT DOES PEI AUTHORIZE YOU TO
UTILIZE QCTool IN APPLICATIONS OR SYSTEMS WHERE
QCTool's FAILURE TO PERFORM CAN REASONABLY BE



EXPECTED TO RESULT IN A SIGNIFICANT PHYSICAL INJURY,
OR IN LOSS OF LIFE. ANY SUCH USE BY YOU IS ENTIRELY AT
YOUR OWN RISK, AND YOU AGREE TO HOLD PEI HARMLESS
FROM ANY CLAIMS OR LOSSES RELATING TO SUCH
UNAUTHORIZED USE.

This Agreement is the complete statement of the Agreement
between the parties on the subject matter, and merges and
supersedes all other or prior understandings, purchase orders,
agreements and arrangements. This Agreement shall be governed
by the laws of the Province of Ontario. Exclusive jurisdiction and
venue for all matters relating to this Agreement shall be in courts and
forums located in the Province of Ontario, and your consent to such
jurisdiction and venue is implied.



Ordering Information.
All orders are subject to the QCTool License Agreement.

To order QCTool online, please click the "Buy Now" button on the
prices page of the QCTool website.

You will receive your Registration Number by email within one
business day after the payment is processed.

Website: www.qctool.ca

https://www.qctool.ca/prices.php
https://www.qctool.ca/


License Registration/Deregistration

To Register a QCTool license If using QCTool in evaluation mode, select Help/Register a
QCTool license from the main menu to enter your serial number. Registration can also be
done by selecting the Register QCTool option from the QCTool folder on the Windows Start
menu. You must have administrative privileges to do this task.

To Deregister a QCTool license
Should you wish to move a registration from one computer to another, simply select
Help/Deregister a QCTool license from the main menu. Then you may install and register
on another computer. This feature is also available by selecting the Deregister QCTool
option from the QCTool folder on the Windows Start menu.



Open command (File menu)
Use this command to open an existing qct-file in a new spreadsheet window.

Shortcuts

Toolbar:

Keys:CTRL+O



Close command (File menu)
Use this command to close all windows containing the active file. QCTool suggests that you
save changes to your file before you close it. If you close a file without saving, you lose all
changes made since the last time you saved it.



Save command (File menu)
Use this command to save the active file to its current name and directory. If you want to
change the name and directory or file format of an existing file before you save it, choose
the Save As command.

Shortcuts

Toolbar:

Keys:CTRL+S



Save As command (File menu)
Use this command to save and name the active file. QCTool displays the Save As dialog
box so you can name your document.

To save a document with its existing name and directory, use the Save command.



Print command (File menu)
Use this command to print a document. This command presents a Print dialog box, where
you may specify the range of pages to be printed, the number of copies, the destination
printer, and other printer setup options.

Shortcuts

Toolbar:

Keys:CTRL+P



Print Preview command (File menu)
Use this command to display the active document as it would appear when printed. When
you choose this command, the main window will be replaced with a print preview window in
which one or two pages will be displayed in their printed format. The print preview toolbar
offers you options to view either one or two pages at a time; move back and forth through
the document; zoom in and out of pages; and initiate a print job.



Print Setup command (File menu)

Use this command to select a printer and a printer connection. This command presents a
Print Setup dialog box, where you specify the printer and its connection.



Exit command (File menu)

Use this command to end your QCTool session. You can also use the Close command on
the application Control menu. QCTool prompts you to save documents with unsaved
changes.

Shortcuts

Mouse:Double-click the application's Control menu button.

Keys:ALT+F4



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to
save:

File Name

Type a new filename to save a document with a different name. QCTool adds the extension
you specify in the Save File As Type box.

Drives

Select the drive in which you want to store the document.

Directories

Select the directory in which you want to store the document.

Network...

Choose this button to connect to a network location, assigning it a new drive letter.

Save As Type

You can choose different file type from the list:

 QCT-file;

 XYZ ASCII file;

 Microsoft Excel;

 Geosoft GBN file.

See Also

Saving Files



Print dialog box

The following options allow you to specify how the document should be printed:

Printer

This is the active printer and printer connection. Choose the Setup option to change the
printer and printer connection.

Setup

Displays a Print Setup dialog box, so you can select a printer and printer connection.

Print Range

Specify the pages you want to print:

All Prints the entire document.
Selection Prints the currently selected text.
Pages Prints the range of pages you specify in the From and To boxes.

Copies

Specify the number of copies you want to print for the above page range.

Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.

Print Quality

Select the quality of the printing. Generally, lower quality printing takes less time to produce.



Print Preview toolbar

The print preview toolbar offers you the following options:

Print

Bring up the print dialog box, to start a print job.

Next Page

Preview the next printed page.

Prev Page

Preview the previous printed page.

One Page / Two Page

Preview one or two printed pages at a time.

Zoom In

Take a closer look at the printed page.

Zoom Out

Take a larger look at the printed page.

Close

Return from print preview to the editing window.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.

Printer

Select the printer you want to use. Choose the Default Printer; or choose the Specific
Printer option and select one of the current installed printers shown in the box. You install
printers and configure ports using the Windows Control Panel.

Orientation

Choose Portrait or Landscape.

Paper Size

Select the size of paper that the document is to be printed on.

Paper Source

Some printers offer multiple trays for different paper sources. Specify the tray here.

Options

Displays a dialog box where you can make additional choices about printing, specific to the
type of printer you have selected.

Network...

Choose this button to connect to a network location, assigning it a new drive letter.
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